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BLACK BOX® Standard Warranty Policy 

BLACK BOX® warrants that all Products manufactured or procured by BLACK BOX® 
conform to BLACK BOX®’s published specifications and are free from defects in materials 
and workmanship for a period of one (1) year from the date of delivery to the original Buyer, 
when used under normal operating conditions and within the service conditions for which 
they were designed. This warranty is not transferable and does not apply to used or 
demonstration products. 

The obligation of BLACK BOX® arising from a Warranty claim shall be limited to 
repairing, or at its option, replacing without charge, any assembly or component (except 
batteries and cable adapters) which in BLACK BOX®’s sole opinion proves to be defective 
within the scope of the Warranty. In the event BLACK BOX® is not able to modify, repair or 
replace nonconforming defective parts or components to a condition as warranted within a 
reasonable time after receipt thereof, Buyers shall receive credit in the amount of the original 
invoiced price of the product. 

BLACK BOX® must be notified in writing of the defect or nonconformity within the 
Warranty period and the affected Product returned to BLACK BOX®’s factory, designated 
Service Provider, or Authorized Service Center within thirty (30) days after discovery of 
such defect or nonconformity. Buyer shall prepay shipping charges and insurance for 
Products returned to BLACK BOX® or its designated Service Provider for warranty service. 
BLACK BOX® or its designated Service Provider shall pay costs for return of Products to 
Buyer. 

BLACK BOX® shall have no responsibility for any defect or damage caused by improper 
storage, improper installation, unauthorized modification, misuse, neglect, inadequate 
maintenance, accident or for any Product which has been repaired or altered by anyone other 
than BLACK BOX® or its authorized representative or not in accordance with instructions 
furnished by BLACK BOX®. 

The Warranty described above is Buyer’s sole and exclusive remedy and no other warranty, 
whether written or oral, expressed or implied by statute or course of dealing shall apply. 
BLACK BOX® specifically disclaims the implied warranties of merchantability and fitness 
for a particular purpose. No statement, representation, agreement, or understanding, oral or 
written, made by an agent, distributor, or employee of BLACK BOX®, which is not 
contained in the foregoing Warranty will be binding upon BLACK BOX®, unless made in 
writing and executed by an authorized representative of BLACK BOX®. Under no 
circumstances shall BLACK BOX® be liable for any direct, indirect, special, incidental, or 
consequential damages, expenses, or losses, including loss of profits, based on contract, tort, 
or any other legal theory. 
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Index of Safety Precautions 
 

BLACK BOX® recommends that the user review all of the information in 
Appendix A before using the TS2000 tester. 

 

Important Notice 
 

Charge Battery Packs Prior to Use 
The battery packs in the Display and Remote Handsets are subject to discharge 
even when the units are turned off. With time on the shelf, the battery pack’s 
charge levels may not support the instrument’s operation. Refer to the User’s 
Guide, Chapter 4 Getting Started, for charging instructions and observe all Safety 
Precautions in the front of the User’s Guide. 



 
 

ii 

Table of Contents 
INDEX OF SAFETY PRECAUTIONS..................................................................................................... I 

IMPORTANT NOTICE ............................................................................................................................. I 

CHARGE BATTERY PACKS PRIOR TO USE ................................................................................................... I 

TABLE OF CONTENTS........................................................................................................................... II 

LIST OF FIGURES .............................................................................................................................. VIII 

LIST OF TABLES ....................................................................................................................................IX 

OPERATION NOTES, CAUTIONS, AND WARNINGS ...................................................................... X 

ABOUT THIS USER’S GUIDE...............................................................................................................XI 

CHAPTER 1  QUICK START .......................................................................................................................XI 
CHAPTER 2  YOUR BLACK BOX® CABLE TESTER .................................................................................XI 
CHAPTER 3 SELF-TESTS, CALIBRATION, AND CONFIGURATION ...............................................................XI 
CHAPTER 4  TS2000 CABLE TESTING FUNDAMENTALS ...........................................................................XI 
CHAPTER 5  AUTOTESTING.......................................................................................................................XI 
CHAPTER 6  ANALYZE TESTING ..............................................................................................................XII 
CHAPTER 7  USING BB RECORD MANAGER SOFTWARE..........................................................................XII 
APPENDIX A  SAFETY PRECAUTIONS.......................................................................................................XII 
APPENDIX B  CUSTOMER SUPPORT .........................................................................................................XII 
APPENDIX C  SPECIFICATIONS.................................................................................................................XII 
APPENDIX D  TIME DELAY REFLECTOMETRY .........................................................................................XII 

CHAPTER 1 QUICK START ................................................................................................................1-1 

CONTENTS..............................................................................................................................................1-1 
WHAT’S IN THE BOX?.............................................................................................................................1-1 
TS2000 TESTER CHARACTERISTICS .......................................................................................................1-2 
TS2000 TESTER OPTIONS AND ACCESSORIES ........................................................................................1-2 
QUICK START PROCEDURES ...................................................................................................................1-3 

Power-up ..........................................................................................................................................1-3 
Self-Test ............................................................................................................................................1-3 
Tester Calibration.............................................................................................................................1-3 
Twisted Pair Cable Connections ......................................................................................................1-4 
Set Autotest Preferences ...................................................................................................................1-5 
Perform Autotest on a Twisted Pair Cable .......................................................................................1-6 

NEXT STEPS ...........................................................................................................................................1-6 
Chapter 2  Your BLACK BOX® Cable Tester...................................................................................1-6 
Chapter 3  Self-Tests, Calibration, and Configuration ....................................................................1-7 



 
 

iii 

Chapter 4  TS2000 Cable Testing Fundamentals ............................................................................ 1-7 
Chapter 5  Autotesting ..................................................................................................................... 1-7 
Chapter 6  Analyze Testing .............................................................................................................. 1-7 
Chapter 7  Using BB Record Manager Software............................................................................. 1-7 

CHAPTER 2 YOUR BLACK BOX®CABLE TESTER....................................................................... 2-1 

CONTENTS ............................................................................................................................................. 2-1 
THE DISPLAY HANDSET......................................................................................................................... 2-1 

The Display Handset........................................................................................................................ 2-1 
Ready Screen.................................................................................................................................... 2-4 
Soft Keys........................................................................................................................................... 2-6 
Display Handset Interface Ports...................................................................................................... 2-8 
Connecting to a Printer ................................................................................................................... 2-9 

THE REMOTE HANDSET ....................................................................................................................... 2-12 
Operational Sequence.................................................................................................................... 2-14 

BATTERY AND POWER MANAGEMENT................................................................................................. 2-14 
Operating the DH and RH from an AC Power Source .................................................................. 2-15 
Battery Charging ........................................................................................................................... 2-16 

CHAPTER 3 SELF TESTS, CALIBRATION, AND CONFIGURATION ....................................... 3-1 

CONTENTS ............................................................................................................................................. 3-1 
SELF-TEST SCREEN................................................................................................................................ 3-1 

Self Test Screens .............................................................................................................................. 3-3 
WARNING SCREENS............................................................................................................................... 3-5 
TESTER FIELD CALIBRATION ................................................................................................................. 3-7 
TESTER CONFIGURATION..................................................................................................................... 3-10 

Entering User Information............................................................................................................. 3-11 
Setting Autotest Preferences .......................................................................................................... 3-12 
Adjusting the Display Contrast ...................................................................................................... 3-13 
Setting Timeout Options................................................................................................................. 3-14 
Setting Length Measurement Units ................................................................................................ 3-15 
Configuring the PC or Printer Interface........................................................................................ 3-16 
Configuring the Talkset.................................................................................................................. 3-17 
Setting Date & Time....................................................................................................................... 3-18 
Selecting a Display Language ....................................................................................................... 3-19 
Restoring Factory Defaults............................................................................................................ 3-20 
Clear Memory ................................................................................................................................ 3-20 

TONE GENERATOR............................................................................................................................... 3-21 
CABLE ID/AUTONAME OPTION........................................................................................................... 3-22 

Cable IDs and Test Numbering...................................................................................................... 3-22 
SELECTING A CABLE TYPE................................................................................................................... 3-28 
CUSTOM CABLE SETTINGS................................................................................................................... 3-31 

Custom Cable Parameters ............................................................................................................. 3-35 



 
 

iv 

CHAPTER 4 TS2000 CABLE TESTING FUNDAMENTALS ...........................................................4-1 

CONTENTS..............................................................................................................................................4-1 
INVASIVE LAN CABLE TESTING ............................................................................................................4-1 
TESTING TWISTED PAIR CABLES ............................................................................................................4-2 

Shielded Twisted Pair (STP).............................................................................................................4-3 
USOC Wiring....................................................................................................................................4-4 
Permanent Link Test Setup ...............................................................................................................4-5 
Channel Test Setup ...........................................................................................................................4-6 

WIRE MAP TEST.....................................................................................................................................4-7 
Wire Map Errors ..............................................................................................................................4-7 
Distance to Fault ..............................................................................................................................4-8 
Troubleshooting Wiremap Problems................................................................................................4-9 

WIRE LENGTH TEST .............................................................................................................................4-10 
Wire Length Errors.........................................................................................................................4-10 
Troubleshooting Wire Length Problems.........................................................................................4-11 

DC RESISTANCE TEST..........................................................................................................................4-11 
DC Resistance Errors .....................................................................................................................4-11 
Troubleshooting DC Resistance Problems .....................................................................................4-12 

NEXT, ELFEXT, AND POWER SUM TESTS..........................................................................................4-13 
NEXT and ELFEXT Errors.............................................................................................................4-14 
Troubleshooting NEXT and ELFEXT Problems.............................................................................4-15 

ATTENUATION TEST .............................................................................................................................4-16 
Attenuation Errors ..........................................................................................................................4-16 
Troubleshooting Attenuation Problems..........................................................................................4-16 

RETURN LOSS TEST..............................................................................................................................4-17 
Return Loss Errors .........................................................................................................................4-17 
Troubleshooting Return Loss Problems .........................................................................................4-17 

AVERAGE IMPEDANCE TEST.................................................................................................................4-18 
Impedance Errors ...........................................................................................................................4-18 
Troubleshooting Impedance Problems ...........................................................................................4-19 

DELAY AND SKEW TEST.......................................................................................................................4-20 
Delay and Skew Errors...................................................................................................................4-20 
Troubleshooting Delay and Skew Problems...................................................................................4-20 

CAPACITANCE TEST .............................................................................................................................4-21 
Capacitance Errors ........................................................................................................................4-21 
Troubleshooting Capacitance Problems ........................................................................................4-21 

ACR TEST............................................................................................................................................4-22 
ACR and Power Sum ACR Errors ..................................................................................................4-22 
Troubleshooting ACR and Power Sum ACR Problems ..................................................................4-22 

HEADROOM TEST .................................................................................................................................4-23 
Headroom Errors ...........................................................................................................................4-23 

TESTING AND TROUBLESHOOTING 10BASE-T CABLING .....................................................................4-24 
TESTING AND TROUBLESHOOTING TOKEN RING CABLING ...................................................................4-25 
TESTING AND TROUBLESHOOTING WITH SPECIAL ADAPTERS...............................................................4-26 

Testing with 110 Connecting Block Adapters.................................................................................4-26 



 
 

v 

Testing with Patch Cable Adapters................................................................................................ 4-26 
Testing with Custom Made Adapters ............................................................................................. 4-27 
Patch Cable Testing....................................................................................................................... 4-28 

CHAPTER 5 AUTOTESTING .............................................................................................................. 5-1 

CONTENTS ............................................................................................................................................. 5-1 
AUTOTEST OVERVIEW ........................................................................................................................... 5-1 

Test Suites ........................................................................................................................................ 5-1 
Test Setup ......................................................................................................................................... 5-4 
Test Sequence................................................................................................................................... 5-5 

AUTOTEST PREFERENCES ...................................................................................................................... 5-6 
Setting your Autotest Preference Options ........................................................................................ 5-6 

RUNNING AUTOTEST ............................................................................................................................. 5-7 
INTERPRETING AUTOTEST RESULTS ...................................................................................................... 5-9 

Pass/Fail Reporting ......................................................................................................................... 5-9 
Viewing Current Autotest Results .................................................................................................. 5-11 
Understanding Test Failures ......................................................................................................... 5-12 
Using Jobs to Store Test Results .................................................................................................... 5-13 
Saving Current Autotest Results .................................................................................................... 5-15 
Printing Current Test Results ........................................................................................................ 5-17 
Viewing or Deleting Stored Autotest Results ................................................................................. 5-19 

AUTOTEST GRAPHS ............................................................................................................................. 5-22 
Graphing Facts .............................................................................................................................. 5-22 
Graph Formats, Layouts, and Controls ......................................................................................... 5-25 

CHAPTER 6 ANALYZE TESTING ..................................................................................................... 6-1 

CONTENTS ............................................................................................................................................. 6-1 
ANALYZE SINGLE TEST MODE OVERVIEW ............................................................................................ 6-1 

Analyze Test Descriptions and Availability ..................................................................................... 6-2 
Test Setup ......................................................................................................................................... 6-2 
Test Sequence................................................................................................................................... 6-3 
Analyze Test Screens........................................................................................................................ 6-3 
Analyze Test Limitations .................................................................................................................. 6-3 

RUNNING A SINGLE TEST....................................................................................................................... 6-4 
Interpreting Analyze Test Results .................................................................................................... 6-5 
Printing Analyze Test Results .......................................................................................................... 6-5 
Analyze Graphs................................................................................................................................ 6-6 

CHAPTER 7 USING BB RECORD MANAGER SOFTWARE......................................................... 7-1 

CONTENTS ............................................................................................................................................. 7-1 
SYSTEM REQUIREMENTS........................................................................................................................ 7-1 
BB RECORD MANAGER INSTALLATION, STARTUP, AND NAVIGATION .................................................. 7-2 

Installation Procedure ..................................................................................................................... 7-2 
Starting the BB Record Manager Program ..................................................................................... 7-2 

TESTER TO PC CONNECTIVITY .............................................................................................................. 7-3 
PC Cable.......................................................................................................................................... 7-3 



 
 

vi 

Establishing a Connection................................................................................................................7-4 
BB RECORD MANAGER USER INTERFACE..............................................................................................7-6 

The Menu Bar ...................................................................................................................................7-6 
The File menu ...................................................................................................................................7-7 
The Edit Menu ..................................................................................................................................7-9 
The View Menu ...............................................................................................................................7-11 
The Options Menu ..........................................................................................................................7-12 
The Help Menu ...............................................................................................................................7-12 
The Status Bar ................................................................................................................................7-12 
The Toolbar ....................................................................................................................................7-13 
The Right Mouse Button .................................................................................................................7-14 

BB RECORDS MANAGER HELP SYSTEM OVERVIEW.............................................................................7-14 
Help Topic Menu Option ................................................................................................................7-14 
Help Topics Screen .........................................................................................................................7-14 
Using Help Screen ..........................................................................................................................7-17 
About BBRM Screen .......................................................................................................................7-18 

PROGRAM CONFIGURATION .................................................................................................................7-19 
WORKING WITH DATABASES................................................................................................................7-20 

Creating a New Database...............................................................................................................7-20 
Opening an Existing Database .......................................................................................................7-21 

WORKING AT THE JOB LEVEL...............................................................................................................7-22 
Navigating the Job Tree..................................................................................................................7-22 
Adding a Job...................................................................................................................................7-23 
Editing Job......................................................................................................................................7-24 
Adding or Editing Customer Details ..............................................................................................7-25 
Adding or Changing the Test Set Operator Name..........................................................................7-26 
Finding a Job or Test......................................................................................................................7-27 

WORKING AT THE TEST LEVEL.............................................................................................................7-28 
Displaying the Test Grid.................................................................................................................7-28 
Viewing Test Details .......................................................................................................................7-29 
Moving Tests Between Jobs ............................................................................................................7-30 
Adding and Editing Tests................................................................................................................7-31 
Sorting the Tests .............................................................................................................................7-32 
Finding Data...................................................................................................................................7-33 

BACKING UP AND RESTORING DATABASES..........................................................................................7-34 
Backing Up a Database..................................................................................................................7-34 
Restoring a Database .....................................................................................................................7-34 
Uploading DH Tests to the PC .......................................................................................................7-35 

PRODUCING AND PRINTING A REPORT..................................................................................................7-37 
Headers and Footers Command.....................................................................................................7-37 
Page Setup Command.....................................................................................................................7-39 
Print Command...............................................................................................................................7-40 
The Single Line Report Layout .......................................................................................................7-41 
The Brief Report Layout .................................................................................................................7-42 
The Detailed Layout .......................................................................................................................7-44 



 
 

vii 

APPENDIX A SAFETY PRECAUTIONS........................................................................................... A-1 

CONTENTS ............................................................................................................................................ A-1 
HANDLE BATTERY PACKS WITH CARE................................................................................................. A-1 
STATEMENT OF LIABILITY .................................................................................................................... A-2 
THANKS FOR HELPING TO PROTECT THE ENVIRONMENT..................................................................... A-2 
IMPORTANT USER INFORMATION.......................................................................................................... A-3 

APPENDIX B CUSTOMER SUPPORT ...............................................................................................B-1 

CUSTOMER SERVICE ..............................................................................................................................B-1 
Technical Assistance ........................................................................................................................B-1 
Service in the USA ...........................................................................................................................B-1 
Service Outside the USA ..................................................................................................................B-2 

WORLD WIDE WEB ...............................................................................................................................B-3 

APPENDIX C SPECIFICATIONS....................................................................................................... C-1 

STANDARD AND OPTIONAL CABLES, ADAPTERS, AND ACCESSORIES....................................................C-1 
ENVIRONMENTAL AND PHYSICAL SPECIFICATIONS................................................................................C-2 

Temperature Range..........................................................................................................................C-2 
Humidity...........................................................................................................................................C-2 
Shock/Bench Handling.....................................................................................................................C-2 
Connector Stress ..............................................................................................................................C-2 
Dimensions and Weight ...................................................................................................................C-3 
Battery and Power Management......................................................................................................C-3 
Instrument Specifications.................................................................................................................C-4 

APPENDIX D TIME DELAY REFLECTOMETRY ......................................................................... D-1 

How TDR Works ............................................................................................................................. D-1 
TDR APPLICATIONS ............................................................................................................................. D-1 
HOW TO PERFORM TDR ....................................................................................................................... D-4 

Test Setup ........................................................................................................................................ D-4 
Running a TDR Analyze Function .................................................................................................. D-5 

THE TDR PLOT .................................................................................................................................... D-6 
TDR Plot Layout and Controls ....................................................................................................... D-6 
Viewing TDR Results ...................................................................................................................... D-7 
Interpreting TDR Results ................................................................................................................ D-9 
Storing, Retrieving, and Deleting TDR Results ............................................................................ D-11 

 



 
 

viii 

List of Figures 
FIGURE 1-1: CONTENTS OF PACKAGE ........................................................................................................ 1-1 
FIGURE 2-1: DISPLAY HANDSET FRONT PANEL ......................................................................................... 2-2 
FIGURE 2-2: READY SCREEN...................................................................................................................... 2-4 
FIGURE 2-3: DISPLAY HANDSET INTERFACE PORTS ................................................................................... 2-8 
FIGURE 2-4: REMOTE HANDSET............................................................................................................... 2-12 
FIGURE 2-5: TESTER AC ADAPTER .......................................................................................................... 2-15 
FIGURE 3-1: TESTER FIELD CALIBRATION SETUP....................................................................................... 3-7 
FIGURE 3-2: TYPICAL TONE GENERATOR SETUP...................................................................................... 3-21 
FIGURE 3-3: CUSTOM CABLE PARAMETER SCREEN ................................................................................. 3-35 
FIGURE 4-1: TWISTED PAIR CABLES .......................................................................................................... 4-2 
FIGURE 4-2: SHIELD CONTINUITY TEST CONNECTIONS TWISTED PAIR ...................................................... 4-3 
FIGURE 4-3: PERMANENT LINK TEST CONNECTIONS ................................................................................. 4-5 
FIGURE 4-4: CHANNEL TEST CONNECTIONS .............................................................................................. 4-6 
FIGURE 4-5: 10BASE-T CONNECTOR...................................................................................................... 4-24 
FIGURE 4-6: TOKEN RING TEST CONNECTIONS........................................................................................ 4-25 
FIGURE 4-7: CORD TEST OPTIONS............................................................................................................ 4-28 
FIGURE 5-1: TABULAR DATA AND GRAPHICAL PLOT LAYOUT ................................................................ 5-26 
FIGURE 7-1: PC UPLOADING CABLE PINOUT ............................................................................................. 7-3 
FIGURE 7-2: PC/TESTER CONNECTION....................................................................................................... 7-4 
FIGURE D-1: TDR GRAPHICAL PLOT........................................................................................................ D-6 
FIGURE D-2: GOOD TDR GRAPHICAL PLOT ............................................................................................. D-9 
 

 

 



 
 

ix 

List of Tables 
TABLE 2-1: DISPLAY HANDSET (DH) FRONT PANEL ................................................................................. 2-3 
TABLE 2-2: READY SCREEN INDICATORS ................................................................................................... 2-5 
TABLE 2-3: READY SCREEN FUNCTIONS .................................................................................................... 2-5 
TABLE 2-3: READY SCREEN FUNCTIONS (CONTINUED).............................................................................. 2-6 
TABLE 2-4: SOFT KEY DESCRIPTIONS ........................................................................................................ 2-7 
TABLE 2-5: DH CONNECTORS.................................................................................................................... 2-9 
TABLE 2-6: SERIAL PORT PIN ASSIGNMENTS ........................................................................................... 2-10 
TABLE 2-7: REQUIRED PC SETTING FOR SERIAL PORT DATA STREAM .................................................... 2-11 
TABLE 2-8: RH BUTTONS, LED’S, AND CONNECTORS ............................................................................ 2-13 
TABLE 3-1: SELF TEST SCREENS ................................................................................................................ 3-3 
TABLE 3-1: SELF TEST SCREENS (CONTINUED).......................................................................................... 3-4 
TABLE 3-2: WARNING SCREENS................................................................................................................. 3-5 
TABLE 3-2: WARNING SCREENS (CONTINUED) .......................................................................................... 3-6 
TABLE 3-3: UNSUCCESSFUL FIELD CALIBRATION CHECKLIST: .................................................................. 3-9 
TABLE 3-4: AUTOTEST PREFERENCE OPTIONS ......................................................................................... 3-12 
TABLE 3-5: DEFAULT TIMEOUT SETTINGS ............................................................................................... 3-14 
TABLE 3-6: SINGLE ID COUNTING SAMPLES............................................................................................ 3-24 
TABLE 3-7: DOUBLE ID COUNTING SAMPLE............................................................................................ 3-25 
TABLE 3-8: CUSTOM CABLE PARAMETER OPTIONS ................................................................................. 3-35 
TABLE 3-8: CUSTOM CABLE PARAMETER OPTIONS (CONTINUED) ........................................................... 3-36 
TABLE 4-1: TWISTED PAIR CABLE TYPES, ASSOCIATED NETWORKS, AND REQUIRED BLACK BOX® 

ADAPTERS: ....................................................................................................................................... 4-3 
TABLE 5-1: PRESET AUTOTEST SUITES AVAILABLE FOR SPECIFIC CABLE TYPES....................................... 5-2 
TABLE 5-1: PRESET AUTOTEST SUITES AVAILABLE FOR SPECIFIC CABLE TYPES (CONTINUED) ................ 5-3 
TABLE 5-2: OVERALL TEST RESULT SYMBOLS .......................................................................................... 5-9 
TABLE 5-3: INDIVIDUAL AUTOTEST REPORTS ............................................................................................ 5-9 
TABLE 5-4: JOB OPTIONS ......................................................................................................................... 5-20 
TABLE 5-5: TEST OPTIONS ....................................................................................................................... 5-21 
TABLE 5-6: AUTOTEST GRAPH VIEW LAYOUT AND CONTROLS ............................................................... 5-27 
TABLE 7-1: OPTIONS PULL-DOWN MENU ................................................................................................ 7-19 
TABLE D-1: TDR GRAPHICAL PLOT LAYOUT AND CONTROLS ................................................................. D-7 
 



 
 

x 

Operation Notes, Cautions, and Warnings 
 

The following symbols are used in this manual to indicate that the user should 
take particular caution in order to prevent injury or damage to the tester or the 
system under test. 

   Exercise caution when you see this symbol. It indicates actions that could 
be harmful to the installer or to the equipment. 

 

  Exercise extreme caution when you see this symbol. It indicates potentially 
lethal voltages. 
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About This User’s Guide 
 
This document contains information and operational procedures that apply to the 
TS2000 tester. 

Chapter 1  Quick Start 
This chapter summarizes information and procedures for tester function, 
unpacking, setup, and operation. 

Chapter 2  Your BLACK BOX® Cable Tester 
This chapter describes the function of all controls and indicators. It also contains 
useful information regarding unit power management. 

Chapter 3 Self-Tests, Calibration, and Configuration 
This chapter describes the Startup screen, Tool icons, and Hard and Soft Key 
menus. It also explains how to run and interpret Self-Tests, respond to Warning 
screens, calibrate and configure the tester, and use the Tone Generator and Audio 
Talk Set. 

Chapter 4  TS2000 Cable Testing Fundamentals 
This chapter describes test setup, physical and electrical characteristics of cables, 
test descriptions, and test storage and data management procedures. This chapter 
also describes how to set up different cabling tests, what to do when tests fail, and 
typical causes of test failure. 

Chapter 5  Autotesting 
This chapter describes the Autotest function, and provides instructions for setting 
up test preferences. This chapter also describes individual tests that run during an 
Autotest, and provides instructions for viewing and interpreting Autotest results. 



 
 

xii 

Chapter 6  Analyze Testing 
This chapter describes the Analyze test function, and provides instructions for 
setting up test preferences and running an Analyze test. This chapter also 
describes each Analyze test, and provides instructions for viewing and 
interpreting test results. 

Chapter 7  Using BB Record Manager Software 
This chapter contains procedures for BB Record Manager software installation, 
configuration, operation, uploading test data into a PC database, and viewing and 
printing test reports. 

Appendix A  Safety Precautions 
This appendix reviews safety information regarding setup and use of the tester. 

Appendix B  Customer Support 
This appendix contains information regarding Customer Service and Tech 
Support. 

Appendix C  Specifications 
This appendix contains information regarding standard and optional cables, 
adapters, accessories, and unit specifications. 

Appendix D  Time Delay Reflectometry 
This appendix contains information regarding TDR applications and examination 
of results. 
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Contents 
• Feature information for the experienced LAN cable tester 

• Quick steps for tester calibration, setup, test modes, and operation 

What’s in the Box? 

  

Figure 1-1: Contents of Package 
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TS2000 Tester Characteristics  

Frequency Test Range 300 MHz 

Highest Level of Standards Category Compliance CAT 6,Class E 
with Headroom 

Accuracy Level III 

Number of Test Records Stored 1500 

Protective Rubber Boot on Both Handsets Yes 

Built-In Tone Generator Yes 

Talkset Capability Yes 

BB Record Manager Software Program Included Yes 

Use with Additional Remote Handset Yes 

Fiber Optic Cable Testing Capability Yes 

Deluxe Hard Shell Carrying Case Included Yes 

Basic/Permanent Link Adapter Yes 

Channel Link Adapter Yes 

 

TS2000 Tester Options and Accessories 

110-Block Adapter Set Yes 

Token Ring Adapter Set Yes 

COAX Adapter Kit Yes 

Dual-Bay, Battery Quick Charger Yes 

Spare/Replacement Battery Yes 

Fiber Optic Cable Testing Capability Yes 
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Quick Start Procedures 
The objective of this section is to supply a highly experienced cable installer with 
enough information to perform an Autotest on a twisted pair cable. 

Power-up 

Power up the Display Handset by pressing the On/Off key. 

Note: The Remote Handset will be powered up automatically by the Display Handset 
when the test begins. 

Self-Test 

When the TS2000 tester is turned on, it displays a Self-Test In Progress message 
and performs a quick self-test.  An alert message is displayed if the self-test 
determines that calibration or repair is necessary. 

Tester Calibration 

A calibration screen will always appear 24 hours after the last field calibration.  
To recalibrate the tester perform the following steps: 

1. Connect the DH and RH end-to-end using the Field Calibration Adapter. 

2. From the DH Ready screen, select the Field Calibration icon. 

3. Press the Tone Key on the RH. The unit turns on and indicates a test is 
running. 

4. Select the Run option on the DH. 

If the calibration was successful, remove the Field Calibration Adapter and 
proceed to the next section. 
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If the calibration was unsuccessful, proceed to Chapter 3, Tester Field 
Calibration. If you are unable to fix the problem, contact your local distributor or 
a BLACK BOX® Tech Support for assistance. 

Twisted Pair Cable Connections 

Most Autotests are performed with the DH and RH connected at opposite ends of 
the cable under test. The minimum level of connectivity required depends on the 
test and cable type selected. 

• Some tests can be performed without the RH. Stored test results or test 
printouts will indicate the presence or absence of the RH during the test. 

• If the test requires the RH, the DH will first attempt to communicate with the 
RH. If unable to communicate, the DH will display a message that it is 
looking for the RH.  

Observe the following cautions while connecting the tester. 

Shielded Cabling Systems 

 Do not create testing ground loops with shielded cable systems. 
Shielded cable systems (i.e., Token Ring, 4 pair STP, or Coaxial) 
present a unique testing problem due to the cable shield’s ground 
connection.  The TS2000 units can test these systems to specifications 
only if the handsets are operated on battery power and not connected to 
a PC or printer using a copper serial cable. 
 
If connection to a printer or PC is essential to perform testing, BLACK 
BOX® recommends using battery operated devices and removing any 
wall power charging inputs.  If this is not possible, an optically isolated 
serial cable should be used during testing to isolate the tester from all 
other ground connections. 
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TELCO Lines 

 
Do not connect the tester to live/active TELCO lines. If you 
accidentally plug the unit into outlets with active TELCO present 
(indicated by a “Voltage Exceeds Limits” warning message) disconnect 
the tester immediately.  

Permanent Link Test Setup 
1. Attach the Permanent Link Adapters to both the Display and Remote 

Handsets. 

2. On the horizontal network cable to be tested, disconnect the corresponding 
user patch cords from the network patch panel and the RJ-45 wall outlet. 

3. Connect the DH Permanent Link Adapter to the network patch panel, and the 
RH Permanent Link Adapter to the wall outlet. 

Note: Don’t forget to change the Cable Type to Permanent Link. 

Channel Test Setup 
1. Attach the Channel Adapters to both the Display and Remote Handsets. 

2. On the horizontal network cable to be tested, disconnect the corresponding 
user patch cords from the network equipment. 

3. Connect the DH Channel Adapter to the network patch panel user patch cord, 
and the RH Channel Adapter to the wall outlet user patch cord. 

Note: Don’t forget to change the Cable Type to Channel. 

Set Autotest Preferences 

Autotest is the most frequently used test mode. A number of preferences can be 
selected for the Autotest function. The tester can be set to: 

• Stop on a test failure 
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• Automatically save test results 

• Automatically increment test names 

• Display graphs of passed tests 

To set Preferences: 

1. Open the Autotest Preferences screen. Set preferences as required (refer to 
Chapter 3, Set Autotest Preferences). 

Perform Autotest on a Twisted Pair Cable 

The selection of cable type determines the default tests included in an Autotest 
suite. 

1. Select the Cable Type (refer to Chapter 3, Selecting Cable Type). 

2. Press the Autotest    key to begin testing. The cable tester will perform a 
predefined test suite. 

3. The test result is displayed below the Title Bar at the top right corner. A boxed 
checkmark    indicates an overall pass. 

4. To interpret, save, or print an Autotest result, refer to Chapter 5, Autotesting. 

Next Steps 
Refer to the following chapters for more information regarding the setup and 
operation of the TS2000 tester. 

Chapter 2  Your BLACK BOX® Cable Tester 

This chapter describes the TS2000 tester controls, indicators, and screens. It also 
contains information regarding tester power management. 
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Chapter 3  Self-Tests, Calibration, and Configuration 

This chapter also explains how to run and interpret Self-Tests, respond to 
Warning screens, calibrate and configure the tester, and use the Tone Generator 
and Audio Talk Set. 

Chapter 4  TS2000 Cable Testing Fundamentals 

This chapter describes physical and electrical characteristics of cables, test 
descriptions, and test storage and data management procedures. This chapter also 
describes how to set up different cabling tests, what to do when tests fail, and 
typical causes of test failure. 

Chapter 5  Autotesting 

This chapter describes the Autotest function, and provides instructions for setting 
up test preferences. This chapter also describes individual tests that run during an 
Autotest, and provides instructions for viewing and interpreting Autotest results. 

Chapter 6  Analyze Testing 

This chapter describes the Analyze test function, and provides instructions for 
setting up test preferences and running an Analyze test. This chapter also provides 
instructions for viewing and interpreting test results. 

Chapter 7  Using BB Record Manager Software 

This chapter describes how to upload test data from the TS2000 tester to an IBM-
compatible PC, and how to organize and print the test data. 
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Chapter 2
Your BLACK BOX®Cable Tester

 

Contents 
• Tester controls and indicators 

• Tester Ready screen 

• Useful information about power management 

The Display Handset 
The TS2000 is a high-performance, portable LAN cable tester designed to test 
and measure twisted pair and coaxial cable used for high speed data 
communications networks. 

The Display Handset 

Figure 2-1 shows the controls and indicators of the Display Handset (DH). Table 
2-1 provides a brief description of each DH feature. 
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Figure 2-1: Display Handset Front Panel 
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Table 2-1: Display Handset (DH) Front Panel 

Callout DH Front Panel Description 

1  Graphical Display Present menus, test results, graphs, action choices 
and option keys. 

2  Option Keys  Select menu options displayed on screen. 

3   Autotest Key Perform a fast suite of tests. Test results are 
presented as pass/fail.  Suites for established 
standards are preprogrammed in the tester. 

4  Arrow Keys Allow up, down, left, and right movement on the 
display. 

5  Wiremap Key Find shorts, opens and miswires such as split and 
reversed pairs. 

6  Length Key Initiate a Length test. 

7  Enter Key Select a highlighted option.  Save changes. 

8  Alphanumeric Keys Enter numbers, letters or special characters.  
Select numbered menu options. 

9  Escape Key Abort and exit the current screen without making 
changes. 

10  Cable Selection Key Select a cable type. 

11  Backlight Key Toggle the screen backlight on/off. 

12  On/Off Switch Power the Display Handset on/off. 

13  Low-Crosstalk 
Connector Port 

Connect a test access cable. 

14  Talkset Jack Connect an Optional Talkset. 

15  DB-9 Serial Port Printer and PC upload port. 
Also used to load software upgrades. 

16  DC Input Jack Connect an external power supply. 
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Ready Screen 

The Ready screen appears when the unit is powered up (if the unit has been 
calibrated within 24 hours) or after field calibration. 
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Figure 2-2: Ready Screen 
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Table 2-2: Ready Screen Indicators 

Indicator Function Description 

1 Memory Usage Display the total number of records stored. 

2 Battery Meter 
 
 
AC Cable 

Display remaining battery power level (from 
Empty to Full). 
 
Indicate when the unit is running off AC power. 

3 Talk Set Indicator Indicate when the Talk Set function is available. 

4 Screen Title Display the Screen Title. 

5 Time and Date Display time and date information. 

6 Setting Display the cable type selected for testing. 

7 Label Display the current job name. 

8 Label Display the screen title for the highlighted 
function. 

 

Table 2-3: Ready Screen Functions 

Icon Function Purpose 

9 Cable ID Select the cable naming function. 

10 Test Record Select the stored test file manager. 

11 Field Calibration Select the field calibration screens. 

12 Preferences Select the instrument preferences screen. 

(Table Continues) 
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Table 2-3: Ready Screen Functions (Continued) 

Icon Function Purpose 

13 Instrument 
Information 

Select the instrument information screen. 

14 Analyze Select option to perform individual cable tests 
(real time). 

15 Talk Set Select Activate/deactivate the Talk set function. 

16 Help Select the Information Screen. 

 

Soft Keys 

User options will often appear at the bottom of the tester display screen. These 
action items (soft keys) are positioned over the three function keys directly below 
the display screen. To select an action item, press its corresponding function key. 

In the example below, you would press the Function keys directly 
below  or   to adjust the Timeout options. 

 
 
 
 
 
 
 
 

 

Soft Keys  

Function Keys     
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Table 2-4: Soft Key Descriptions 

Soft Key Description 

 
Okay or confirm an action. 

 
Stop or cancel an action. 

 
Print data. 

 
Save data using Auto Increment naming convention. 

 
Overwrite or rename data. 

 
Run the selected test in continuous mode (real time). 

 
Page-up for information. 

 
Page-down for information. 

 
Select/Deselect an item in a list box. 

• Check boxes are on-off switches. 

• If a check box is turned on, the box will contain a check 
mark. 

 
Select an action item. 

 
Activate/Deactivate the Talk Set option. 

 
Delete characters. 

 



Chapter 2 
Your BLACK BOX® Cable Tester 

 

2-8 

Display Handset Interface Ports  

1

2

34
 

Figure 2-3: Display Handset Interface ports 
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Table 2-5: DH Connectors   

Callout Connector Description 

1 Low-
Crosstalk 
Connector 

Attach adapters for all types of cables. 

2 DB-9 Serial 
Port 

Supports the following functions: 

• Print test results on a serial printer. 

• Upload stored test results to a PC. 

• Load firmware upgrades. 

3 DC Input 
Jack 

Used to charge the battery in the handset. 

4 Talkset Jack Used to connect the optional Talkset to the tester. 

 

Connecting to a Printer 

Test results can be printed during Autotest, Fault Find or from memory using a 
serial printer. The testers are compatible with any serial printer that conforms to 
Epson or ASCII serial printer commands. 
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To connect a printer: 
1. Connect the tester to the printer serial port. 

2. Make sure the printer is powered up and on-line. 

3. The tester is capable of supporting a baud rate of up to 115,000. Determine 
the printer baud rate, handshake  (XON/XOFF is ON or OFF), and change 
the defaults using the Preferences screen. Refer to Chapter 3, Self-Tests, 
Calibration, and Configuration for setup information. 

Table 2-6: Serial Port Pin Assignments 

Pin DTE Mode DCE Mode 

1 Data Carrier Detect Data Carrier Detect 

2 Transmit Receive 

3 Receive Transmit 

4 Data Terminal Ready Data Terminal Ready 

5 Ground Ground 

6 Data Set Ready Data Set Ready 

7 Ready To Send Ready To Send 

8 Clear To Send Clear To Send 

9 Not Connected Not Connected 

S Shield Shield 

Note: DTE - DCE is selectable in the Setup menu, however DTE is the  
Default Mode. 
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Table 2-7: Required PC Setting for Serial Port Data Stream  

Parameter Setting 

Data Length 8 bits, no parity 

Start/Stop bit 1/1 

Speed 1200 to 115,000 baud rate user selectable 

Control CTS  
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The Remote Handset 

The RH (Remote Handset) works with the DH (Display Handset) to perform 
Autotest or individual real time Analyze tests. The RH terminates the cable link 
and communicates with the DH. The RH is automatically activated by the DH and 
does not have a separate power-on key. The RH does need to have power 
available when performing a field calibration, otherwise, the DH will not find it. 

Figure 2.4 shows the controls and indicators of the Remote Handset (RH).  
Table 2-8 provides a brief description of each RH feature. 
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Figure 2-4: Remote Handset 
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Table 2-8: RH Buttons, LED’s, and Connectors 

Callout RH Front Panel Description 

1 Pass LED Successful test results 

2 Fail LED Unsuccessful test results 

3 Testing LED Test in progress 

4 Talkset LED Talkset is active 

5 Tone LED Toner is in operation 

6 High Voltage LED Excessive line voltage present (TELCO) 

7 No Patch Cable LED No patch cable connected 

8 Battery Level LED’s Remaining battery life 

9 Tone switch Press to activate/deactivate Toner 

10 Low-Crosstalk 
Connector Port 

A test access cable connector 

11 DB-9 Serial Port Use to interface to a PC 

12 Talkset Jack Connect an Optional Talkset 

13 DC Input Jack Connect an external power supply 
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Operational Sequence 

• The DH searches for the RH. 

• During testing, if the two handsets are unable to communicate, the DH will 
display a message that it is searching for the RH and continue trying to 
establish communications until you manually cancel the operation or the RH 
is found.  If the handsets are unable to establish communication, check the 
links to verify proper connection. 

• During field calibration, if the two handsets are unable to communicate, the 
DH will display a message instructing you to connect the DH and RH together 
using the calibration adapter. If you attempt to run the test without the adapter, 
the DH will display a warning message. 

• After a brief period of inactivity, the RH automatically powers down to save 
battery power. 

Battery and Power Management 

Both the Display and Remote Handsets use interchangeable, rechargeable NiMH 
(Nickel Metal-Hydride) battery packs.  

• The DH (Display Handset) can be run on battery power for approximately 
eight hours. Actual battery power times will vary because of factors such as 
the tester model, operating time versus standby time, use of the display 
backlight, and temperature. 

• When the battery is almost empty, the tester displays a warning message. The 
tester will automatically shut down before testing results are affected. 

• The RH (Remote Handset) can be run on battery power for approximately ten 
hours. 
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Operating the DH and RH from an AC Power Source 

The DH and RH handsets can be operated from an external DC source  
(Wall Cube). 

 

Figure 2-5: Tester AC Adapter 

 
When the AC Wall Cube Adapter is used to power the handsets: 

• Both handset batteries will receive a trickle charge. 

• The DH handset will display the AC plug and cable indicator at the top left of 
the screen. 

• All three RH battery power LEDs will illuminate when the unit is activated by 
the DH. 

 
Only the Power Cube provided with the instrument should be used. Other 
types of Power Cubes may cause damage to the tester. 
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Battery Charging  

The handset batteries are recharged using the AC Wall Cube. The DH uses battery 
powered flash ROM to store handset data and settings whenever the battery is 
removed from the tester. The internal flash ROM battery has a three year life 
expectancy. 

Using the AC Wall Cube Adapters: 
• The batteries can be recharged in the handsets (using the AC Wall Cube) in 

about 8 hours. 
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Chapter 3
Self Tests, Calibration, and Configuration

 

Contents 
• Running and interpreting Self Tests 

• Responding to Warning screens 

• Calibrating and configuring the tester 

• Using the Tone Generator and the Audio Talk Set 

• Creating and using custom cable settings 

Self-Test Screen 
If you suspect a problem, self tests can be used to evaluate tester performance. 
The following self test options are available: 

• Instrument 

• Keyboard 

• RS232 Interface 
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To run a self test: 

1. In the Ready screen, select the Instrument    icon and press Enter     
to open the Instrument screen. 
 
The Instrument screen will list a set of user options that can be performed by 
the tester. 

2. Use the Arrow keys to 
position the cursor bar on the 
Self Test option. 

 

3. Press    to open the Self Test screen. 

4. Use the Arrow keys to 
position the cursor bar on the 
desired Self Test option. 
 
In this example, press the 
Down Arrow key once to 
select  Keyboard. 

. 

5. Press Enter     to start  
the Keyboard Test. 
 
The Keyboard Test screen 
displays. 
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6. While the Keyboard Test is running, press suspected bad key(s) and observe 
the display screen for a response. 

7. When you are finished testing, press    to return to the Self Test screen. 

8. For some tests, the Stop/Cancel    button will end the test in progress. 

Self Test Screens 

The Self Test screens allow you to monitor the progress and results of each test. 
Refer to the following table for a brief description of self test screens. 

Table 3-1: Self Test Screens 

Test Screen Description 
Instrument 

 

  The instrument self test was 
successful. 

  The instrument self test has 
failed. 
Press the Run    key and 
proceed to the next error, if there 
has been more than one error. 

Keyboard 

 

The instrument is performing a 
keyboard self test. 

(Table Continues) 
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Table 3-1: Self Test Screens (Continued) 

Test Screen Description 
RS232 Serial 
Interface 

 

The handset is transmitting a test 
message to the RS232 printer 
port. 
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Warning Screens 
In response to a failure, harmful condition, or operational limitation, the tester 
will often display a warning screen. 

Table 3-2: Warning Screens 

Warning Screen Description 
Memory Is 
Almost Full 

1200

 

Tester memory is 80% full.  
 
You must upload or delete data to 
stop this message from appearing. 

Memory Is 
Full 

1500

 

A save operation has filled the 
tester’s memory. 
 
You must upload or delete data to 
stop this message from appearing. 

No Cable 
Present 

 

An operation requiring a cable 
type has been attempted without 
first connecting a patch cable to 
the unit. 
 

(Table Continues) 
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Table 3-2: Warning Screens (Continued) 

Warning Screen Description 
Low Battery 

 

Handset battery voltage is low. 
 
This screen will continue to 
appear every time a Hard key is 
pressed or when you return to the 
Tools screen.  
 
Replace or recharge the battery to 
turn off this warning screen. 

Input Voltage 
Exceeds 
Limits 

 

High voltage has been detected 
on the connector pins. 
 
The warning message will stay on 
until the high voltage is removed. 
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Tester Field Calibration 

The TS2000 tester requires field calibration every 24 hours.  A calibration 
reminder message will appear on the display handset screen when calibration is 
required. 

Before performing field calibration, connect the Display and Remote Handsets 
together using the calibration connectors as shown below. Turn on the power to 
both the DH and RH before performing unit calibration. 
 

Display Handset Remote Handset

Field Calibration Adapter  

Figure 3-1: Tester Field Calibration Setup 

To calibrate the tester:  
1. From the Ready screen, select 

the Field Calibration    
Icon. The Calibration screen 
appears.   
 
Activate the remote handset by 
pressing the Tone Key.  

  

2. Press  to begin the calibration process.  Calibration takes approximately 
one minute. 
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3. If calibration is successful, a 
Calibration Complete  
symbol appears. 

4. After a brief period, the tester 
returns to the Ready screen. 

  

5. If calibration is unsuccessful, the tester will briefly display one of the 
following Error screens. 

  

6. The tester display returns to the Ready screen upon exit from a calibration 
error screen. 

Note: An Autotest failure will occur if the field calibration is out of date. 
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Table 3-3: Unsuccessful Field Calibration Checklist:  

Action Result 
Check the battery power on 
both the Display and Remote 
Handsets. 

Check the DH for a low battery message.  
If the Display Handset indicates a low battery, you 
must recharge the battery before the unit will pass 
calibration. 
 
The RH will not respond if its battery is low. 
 

Check the calibration 
adapter. 

Make sure the adapter is correctly seated and that there 
are no bent pins. 
 

 

If you are unable to successfully calibrate the tester, contact your BLACK BOX® 
Tech Support for assistance. 
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Tester Configuration 
Most tester configuration parameters are set from the Preferences screen. 

To open the Preferences screen: 
1. From the Ready screen, select 

the Instrument    Icon. 
The Preferences screen 
displays. 
 

 
 

2. Use the Arrow keys to select one of the following options: 

• Enter User Information • Configure the Talkset Option 

• Set Autotest Preferences • Set Date & Time 

• Adjust Display Contrast • Select Display Language 

• Set Time-out Options • Restore Factory Defaults 

• Set Measurement Units • Clear Memory 

• Configure the PC & Printer I/F  
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Entering User Information 

User information identifies the unit operator for test reports. 

1. From the Preferences screen, 
select the User Information 
option. The User Information 
screen displays. 
 

 
2. Use the Alphanumeric keys to enter your name. 

3. Use the Down Arrow key to move to the company name or contractor name 
field.  

4. Use the Alphanumeric keys to enter a name. Use the Right Arrow key to 
advance from one character to the next. 

5. Press Enter   to save or Escape   to exit without saving changes. 

 



Chapter 3 
Self Tests, Calibration, and Configuration 

 

3-12 

Setting Autotest Preferences 

Autotest can be set to automatically stop on the first failed test, and to print, save, 
and name test results at the completion of each test series. 

Table 3-4: Autotest Preference Options 

Option Action 
Stop on Fail Autotest aborts at the first failed test. Otherwise, Autotest continues 

until all tests are completed, regardless of results.  
Note: If a wire map cannot be reliably completed due to gross 

miswiring, the Autotest may abort regardless of the setting of 
this preference. 

Auto 
Increment 

Autotest automatically increments the Single and Double Cable ID test 
counters. 

AutoSave Autotest automatically names and saves any passed Autotest results.  
Failed tests are not automatically saved.  

Graphs Displaying graphs on the DH requires data to be transferred from the 
RH to the DH. To save time during testing, do not select this option. 

 
1. From the Preferences screen, 

select the Autotest 
Preferences option. The 
Autotest Preference screen 
displays. 
 
Use the Arrow keys to 
position the cursor next to the 
desired option. 

 

2. Press   to select or deselect an option.  
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3. Press Enter    to activate the selected Autotest Preferences. 

4. Press Enter   to save or Escape   to exit without saving changes. 

Adjusting the Display Contrast 

1. From the Preferences screen, 
select the Display Contrast 
option. The Display Contrast 
screen displays. 

 

 
2. Press the    or   key to adjust the screen contrast.  

3. Press Enter    to save or Escape    to exit without saving changes. 



Chapter 3 
Self Tests, Calibration, and Configuration 

 

3-14 

Setting Timeout Options 

Use this option to set tester time-out options to help conserve battery power when 
the tester is not in use.  

Table 3-5: Default Timeout Settings 

Backlight 30 seconds 
Power 30 minutes 

 

1. From the Preferences screen, 
select Timeout Options. The 
Timeout Options screen 
displays with the cursor on the 
Backlight Timeout option. 

Note: The timers begin counting from 
the last key press. 

 

2. Press the   or  soft key to adjust the Backlight Timeout setting. 

3. Press the down cursor arrow to select the Power Off Timeout option.  

4. Press the  or   soft key to adjust the Power Off Timeout parameter. 

5. Press Enter   to save or Escape    to exit without saving changes.   
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Setting Length Measurement Units 

Use this option to set the unit of measurement parameter for length 
measurements. The unit default setting is “feet.” 

1. From the Preferences screen, 
select the Measurement Units 
Option. The Measurement 
Units screen appears. 

 

2. Select the left or middle option key to set the unit of measure parameter to 
feet or meters.  

3. Press Enter  to save or Escape    to exit without saving changes. 
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Configuring the PC or Printer Interface 

Use this option to configure the serial port and select the type of printer being 
used.   

1. From the Preferences screen, 
select the PC & Printer I/F 
option. The PC & Printer I/F 
screen appears. 

Note: DTE is selected for uploading to 
a PC. DCE is selected for direct 
printing to a printer using the 
serial port. 

 

57600

 

2. Press the Arrow keys to position the cursor next to the desired parameter. 

3. Press the    or    key to select the desired setting. 

4. Press Enter   to save or Escape   to exit without saving changes. 



Chapter 3
Self Tests, Calibration, and Configuration

 

3-17 

Configuring the Talkset 

The TS2000 tester is “talkset ready.” Use this option to establish communications 
between the DH and the RH through an externally attached microphone/headset.  

There are two modes of talkset operation: manual and auto. 

• In manual mode, the talkset option is activated or deactivated using the soft 
keys at the bottom of the DH screen.  

• Selecting Automatic in the Talkset Preference screen will enable the talksets 
after each Autotest.  

During testing (Autotest or Analyze), the talksets are temporarily disabled until 
the test has completed. The talkset stays active until the cable under test 
connection is broken, the talkset cable is unplugged, or the option is deactivated 
by toggling the “speaker” soft key icon at the bottom of the Ready screen.  The 
state of this selection is indicated by the “speaker” icon at the top of each screen 
and the “Talkset LED” on the RH. 

1. From the Preferences screen, 
select the Talkset option. The 
Talkset screen displays. 

2. Press the Arrow keys to 
position the cursor next to the 
desired parameter 
 
The default setting for Talkset 
is “Manual”. Press the    or  

  key to select the desired 
setting. 
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3. To talk with someone using the talkset both the Display Handset and the 
Remote Handset must be connected to a cable with the TS2000 adapters. 

4. Adjust the audible volume in the earpiece by using the volume control wheel 
on the talkset’s cord. 

5. Press Enter     to save or Escape    to exit without saving changes. 

Setting Date & Time 

Accurate date and time settings are necessary to create reliable stored record and 
report information. 

1. From the Preferences screen, 
select the Date & Time 
option. The Date & Time 
screen displays. 

 

 

2. Use the Arrow keys to position the cursor next to the parameter to be 
changed. 

3. Press the    or    keys, or Alphanumeric keys to enter the desired 
setting. 

4. Repeat steps 2 and 3 until the desired parameters have been set. 

5. Press Enter    to save or Escape    to exit without saving changes. 
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Selecting a Display Language 

You can select one of six languages for the tester display screen: 

• English (Default) • Italian 

• French • Portuguese 

• German • Spanish 

 

1. From the Preferences screen, 
select the Language option. 
The Language screen displays. 

 

 

2. Press the    or   key to select the desired language. 

3. Press Enter    to save or Escape     to exit without saving changes. 
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Restoring Factory Defaults 

Use this option to reset all unit parameters to their factory default settings. 

1. From the Preferences screen 
use the Arrow keys to position 
the cursor on the Restore 
Defaults option. 

2. Press the Enter     key to 
set all unit parameters to their 
factory default settings. 

 
 

Clear Memory 

Use this option to clear the tester memory. 

1. From the Preferences screen 
use the Arrow key to position 
the cursor on the Clear 
Memory option. 

2. Press the Enter     key to 
clear tester memory. 

Note: There is no undelete option 
when clear memory is used. All 
stored tests will be permanently 
deleted. 
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Tone Generator 
The RH can generate a “warble” tone (alternating 900 / 1100 Hz tone at 2 Hz 
rate) that is detectable by most standard inductive amplifiers. 

To activate the Tone Generator: 
1. Connect the RH to the cable under test. 

2. Press the Tone key on the RH. 

3. The Tone LED on the RH will illuminate when the Tone Generator is active. 

To turn the Tone Generator off, perform one of the following actions: 
1. Press the Tone button. 

2. Connect the DH to the other end of the link under test. 

3. Allow the tester to remain idle. After five minutes with no test activity the 
Tone Generator automatically turns off. 

Patch Panel

Wall Outlet

Inductive
Probe

Remote
Handset

2 Meter
Basic Link Adapter

 

Figure 3-2: Typical Tone Generator Setup 



Chapter 3 
Self Tests, Calibration, and Configuration 

 

3-22 

Cable ID/AutoName Option 

Cable IDs and Test Numbering 

Single and Double Cable IDs 
There are two levels of AutoName capability: Single and Double ID. The Double 
ID feature has many benefits: 

• Both ends of the cable under test are clearly identified. 

• While reviewing saved test records, potential problems can be identified and 
quickly located. 

If the Autosave Autotest preference is selected, names will automatically be 
assigned to completed tests. 

• You can assign a maximum of two unique ten-character cable names for the 
cable under test (Double ID). 

• The tester defaults to a single naming mode (Single ID). The following three 
screens are examples of unique Single and Double Cable IDs. 

1. Example: 
Single ID 
 
A unique five-character name 
PANEL, followed by a four-
character incrementing counter 
field. The counter is set by 
default or by the user to start at 
0000 and ends at 9999. 
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2. Example: 
Double ID “Cable To” 
 
A unique six character name 
OFFICE, followed by a four 
character incrementing counter 
field. This example set by the 
user to start at 000A and end at 
009D. 

Note: The  button is used to 
switch to the Cable From 
screen. 
 

 
 

3. Example: 
Double ID “Cable From” 
 
A unique five character name 
PANEL, followed by a four 
character incrementing counter 
field. This example set by the 
user to start at 0000 and end at 
9999. 

Note: The  key is used to switch 
to the Cable To screen. 
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Test Counter 
In addition to the cable name, you can assign up to four incrementing characters 
to identify individual tests. A  symbol below a counter field signifies a non-
incrementing field. A  symbol signifies an auto-incrementing field. Like the 
decimal numbering system, the counter always begins incrementing from the right 
most unlocked digit. The default numbering scheme is set to start counting from 
0000, and end at 9999. Custom numbering schemes may be used. Refer to Table 
5-1 and 5-2 for Single and Double ID counter numbering samples. 

Table 3-6: Single ID Counting Samples 

Default Example Custom Examples 

Cable Name: TEST Cable Name: PANEL Cable Name: PANEL 
Start: 0  0  0  0 
End: 9  9  9  9 
Locked:  
Current: 0  0  0  0 

Start: 0  0  0  0 
End: 0  0  2  2 
Locked:  
Current: 0  0  0  0 

Start: 0  0  0  A 
End: 0  9  9  D 
Locked:  
Current: 0  1  8  A 

0  0  0  0 0  0  0  0 0  1  8  A 
0  0  0  1 0  0  0  1 0  1  8  B 
0  0  0  2 0  0  0  2 0  1  8  C 
0  0  0  3 0  0  1  0 0  1  8  D 
0  0  0  4 0  0  1  1 0  1  9  A 
0  0  0  5 0  0  1  2 0  1  9  B 
0  0  0  6 0  0  2  0 0  1  9  C 
0  0  0  7 0  0  2  1 0  1  9  D 
0  0  0  8 0  0  2  2 0  2  0  A 
0  0  0  9 0  0  0  0 0  2  0  B 
0  0  1  0 0  0  0  1 0  2  0  C 
0  0  1  1 0  0  0  2 0  2  0  D 
0  0  1  2 0  0  1  0 0  2  1  A 
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Table 3-7: Double ID Counting Sample 

“Cable To”  “Cable From” 
Cable Name: OFFICE  Cable Name: PANEL 
Cable Counter  Cable Counter 
Start: 0  0  0  A 
End: 0  0  9  D 
Locked:  
Current: 0  0  0  A 

 Start: 0  0  0  0 
End: 9  9  9  9 
Locked:  
Current: 0  0  0  0 

0  0  0  A  0  0  0  0 
0  0  0  B  0  0  0  1 
0  0  0  C  0  0  0  2 
0  0  0  D  0  0  0  3 
0  0  1  A  0  0  0  4 
0  0  1  B  0  0  0  5 
0  0  1  C  0  0  0  6 
0  0  1  D  0  0  0  7 
0  0  2  A  0  0  0  8 
0  0  2  B  0  0  0  9 
0  0  2  C  0  0  1  0 
0  0  2  D  0  0  1  1 
0  0  3  A  0  0  1  2 
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Opening the Single/Double Cable ID Screen: 
1. Select the Cable ID icon to open the main Cable ID screen. 

2. The screen that appears will reflect the most recently assigned Cable ID 
(either single or double).  To toggle between Single and Double ID screens, 
position the cursor over the Select Single or select Double ID option. 

Single ID Screen Double ID Screen 

  

3. The following options may be executed from the main Cable ID screens: 

• Increment Cable ID (Cable From and Cable To in Double ID mode) 

• Set Cable ID (Cable From and Cable To in Double ID mode) 

• Select either Single or Double IDs for tests. 

4. Press Enter   to save changes. 

5. Press   to return to the previous screen after setting the printer 
communication settings. 
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To set a Cable ID: 
1. In the Cable ID screen, 

position the cursor over the  
Set Cable ID option. 

2. Press Enter    to open the 
Double ID screen. 

Note: The screen that appears will 
reflect the most recently 
assigned Cable ID (either 
Single or Double). Double ID is 
used in this example.  

3. Enter the following parameters 
as required: 

a. Cable From name, ten 
characters maximum. 

b. Counter Start and End 
points, four characters 
each. Counter will reset at 
the end point. 

c. Select the  symbol to 
lock a character, or  to  
allow a character to  
auto-increment. 

d. Use the  key to go to 
the Cable To screen. 
Repeat steps a through c. 

 

4. After entering the desired Cable From and Cable To names and parameters, 
press Enter   to save and return to the Main Cable ID screen. 



Chapter 3 
Self Tests, Calibration, and Configuration 

 

3-28 

Selecting a Cable Type 
The tester comes with several  cable types stored in non-volatile memory. When a 
cable type is selected, the recommended limits for that cable are automatically 
programmed into the tester. 

Cable choices are made by topology: 

• Twisted Pair Basic  • Token Ring 

• Twisted Pair Channel  • Custom Cable 

• Miscellaneous Types • Fiber 

• Ethernet  

Note: The TS2000 tester can also support custom cable types. 

To select a cable type: 
1. Press the Cable Selection  

 hard key. The Cable 
Types screen appears. 

2. Press Enter   to select a 
cable type and its associated 
default NVP for testing. 
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3. Position the cursor and press 
Enter   to change to a new 
cable type and its associated 
default NVP for testing. 
 
The Information screen 
appears briefly to confirm your 
cable selection. 

Note: A number of unique cable 
manufacturer NVP values are 
stored in the tester memory. To 
access the list of manufacturer 
cables for the currently 
highlighted test standard, press 
the   soft key. 

 

4. Press the    soft key if you 
want to use the selected cable 
as the basis for a Custom 
Cable.  The tester will display 
the Custom Cable screen. 
You can then change default 
cable features and save the 
cable as a Custom Cable. 
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To change the default NVP value:  
1. From the Test Standard screen, 

press the   key to select 
the Change NVP option. The 
NVP screen will display. 

 

2. To manually enter a new NVP value, use the Arrow keys to position the 
highlighted cursor and enter new NVP values. 

3. To automatically calculate a new NVP value, press   to select the 
Measure NVP option.  The Measure NVP screen appears. 

4. Connect a test cable of known length. 

5. Using the Arrow and Number keys, enter the known cable length. 

6. Press the     key to calculate a new NVP value. The display returns to the 
main NVP screen after the new NVP value has been calculated. 

Note: For ISO Standards enter the known cable length plus 4 meters. 
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Custom Cable Settings 
All of the cable types pre-programmed into the TS2000 tester are associated with 
a predefined test standard. You cannot change these pre-programmed parameters. 
If you want to run a different set of tests for a given cable you must create a 
Custom Cable.  

For example, if you would like to run Return Loss in addition to the TIA 568A 
TSB-67 Category 5 tests (Return Loss is not a required TIA or TSB-67 test), you 
must create a Custom Cable and select the tests you want to include in the test 
suite for this cable. 

A maximum of ten custom cable settings can be created, stored, removed and 
retrieved when needed. 

To create a new custom cable type: 
1. Press the Cable Selection  

  hard key.  The Cable 
Types screen displays. 

2. Use the arrow keys to position 
the cursor over the desired 
cable topology cursor and 
press Enter   . 
The Test Standard screen 
displays. 
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3. Position the cursor over the 
desired cable type and press 
the  key.  The Custom 
Cable parameters screen 
displays. 

 

4. Change the desired cable 
parameters, then proceed to the 
next step to name the cable. 

5. Position the cursor over 
Custom Name/NVP and press 
Enter .  The NVP Screen 
appears. 

 
 

6. Change NVP parameters as 
required and then name your 
new custom cable. 

7. Press the Save function key. 

8. Press Enter   to return to 
the Custom Cable screen. 
The new custom cable is now 
selected as the cable under test.
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To select or delete a custom cable type: 
1. Press the Cable Selection  

  hard key. The Cable 
Types screen appears. 

 

 

2. Press the arrow keys to select Custom Cable. 

3. Press Enter   to open the Custom Cable screen. 

4. The tester displays any stored 
custom cable types. 

5. Position the cursor over the 
desired custom cable type. 

6. Press Enter   to make the 
custom cable you highlighted 
the new cable type, or press the  

  key to delete the 
selected custom cable type. 

 

 

Note: Custom cables can not be deleted if there are stored tests associated with 
the cable. 

 



Chapter 3 
Self Tests, Calibration, and Configuration 

 

3-34 

To edit an existing custom cable type : 
1. Press the Cable Selection    hard key. The Cable Types screen appears. 

2. Open the Custom Cable screen 
and select the cable type to be 
customized. 

3. Press the  soft key.  
The Custom Cable parameter 
screen displays. 

Note: Custom cables can not be 
deleted if there are stored tests 
associated with the cable. 

 
 

4. Position the cursor on the 
desired custom cable 
parameter and press the Enter 

 key to edit the settings. 

 

FREQUENCY RANGE
CONNECTOR PINOUT
TEST LIMITS
LINK MODELS
SELECT AUTOTESTS
ADAPTERS
CUSTOM NAME/NVP

SELECT AUTOTESTS

 

5. After making the desired changes, select the Custom Name/NVP option. 
The NVP screen displays. 

6. Save the cable under its current name or under a new name 

Note: Refer to the next page for a description of custom cable parameter options. 
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Custom Cable Parameters 

1
2

3
4

5
6

7

FREQUENCY RANGE
CONNECTOR PINOUT
TEST LIMITS
LINK MODELS
SELECT AUTOTESTS
ADAPTERS
CUSTOM NAME/NVP

 

Figure 3-3: Custom Cable Parameter Screen 

Table 3-8: Custom Cable Parameter Options 

 Parameter Option Description 
1. Frequency Range 

 
Use this menu to set minimum and maximum 
certification and cable grade frequencies. 
 

2. Connector Pinout This screen is used to define connector pinouts.  
Note: If one wire pair is not selected, tests for NEXT, 

attenuation, capacitance, DC resistance, and 
impedance will not be performed on that pair. 

3. Test Limits This screen is used to customize Autotest pass/fail 
limits. 
 

(Table Continues) 
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Table 3-8: Custom Cable Parameter Options (Continued) 

 Parameter Option Description 
4. Link Models Custom NEXT and Attenuation limits are set by 

using a flat line limit or one of several different 
models. Frequency limits will vary from less than 1 
MHz to 100 MHz based on the link type. 
 

5. Select Autotests Not all cables will require the full suite of Autotests. 
Use this menu to select the Autotests to be run. 
 

6. Adapters Use this menu to inform the tester which near-end 
and far-end cable adapter are currently being used. 
 

7. Custom Name/NVP 
 

Use the alphanumeric keys to enter a custom name or 
change the NVP parameters. The TS2000 can store 
up to 10 custom cables. 
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Contents 
• Physical and electrical characteristics of cables 

• Cable test descriptions 

• How to set up different cabling tests 

• What to do when tests fail 

Invasive LAN Cable Testing 
Whenever an electronic test instrument is connected to a circuit to obtain a 
reading, that unit and its connecting cables become part of the “circuit-under-
test.” To some extent, the reading will always reflect the instrument’s 
participation in the measurement. BLACK BOX®’s goal has always been to 
reduce to an absolute minimum the effects the instrument has on the circuit. 

A TS2000 tester uses special instrument connectors instead of RJ-45  
(Modular 8) style jacks for the following reasons: 

• RJ-45 connectors add significant crosstalk to higher frequency measurements. 

• TIA/EIA’s proposed standards exclude the RJ-45 connection from the end of 
the model links used to define current LAN cable testing limits. 

• RJ-45 connecting hardware is limited to 500-1000 mating cycles before 
requiring replacement. 
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Testing Twisted Pair Cables 
Twisted pair wiring systems (Refer to Figure 4-1) typically employ four pairs of 
insulated conductors and connectors that allow you to operate different network 
types on the same cable (Refer to Table 4-1). Both unshielded (UTP) and foil 
shielded (STP, FTP) cables are available. 

Jacket
Insulation

Tinned Copper Stranded
or Solid Conductor
(4 Pairs)

Copper Drain Wire
(Shielded Cable only; STP)

Aluminum-Polyester Shield
(Foil Shielded Cable only; FTP)  

The following diagrams contain modular jack pin numbering and wiring 
patterns for T568A, T568B, 10 Base-T, TP-PMD, Token Ring and USOC 
cabling types. 

 

Figure 4-1: Twisted Pair Cables 
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Table 4-1: Twisted Pair Cable Types, Associated Networks, and Required 
BLACK BOX® Adapters: 

Cable Type Network Examples Required Adapters 
TIA Cat 3, 4, 5, 5 Gbit, 
5E, and 6 UTP or STP 

Ethernet, Fast Ethernet, ATM, 
and Gigabit Ethernet 

Permanent Link or 
Channel  

ISO Class C, D, and E 
UTP or STP 

Ethernet, Fast Ethernet, ATM   

TP-PMD / TP-DDI FDDI or ATM on Copper  
10Base-T Ethernet  
Single Pair Telephone, Apple Local Talk, 

ISDN 
 

Shielded Two-Pair 
(1,2,7,8) 

ATM, Fiber Channel on 
Copper 

 

 

Shielded Twisted Pair (STP) 
Testing the continuity of the shield is important and requires shielded test leads at 
both the Display Handset and Remote Handset. When testing STP, be sure to 
select Shielded Cable Type (STP) in the Cable Type menu. 

 

Figure 4-2: Shield Continuity Test Connections Twisted Pair 
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USOC Wiring 
If a USOC (Universal Service Ordering Code) or other wiring scheme is used, a 
special adapter may be required for connection. Refer to Appendix C, Model 
Accessories for a full list of available cable adapters. 

Note: If your testing requirements include connection to something other than an RJ-45 
style jack, refer to Testing with Special Adapters later in this chapter. 
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Permanent Link Test Setup 
ANSI, EIA, TIA, and ISO all provide two network communication circuit 
specifications: basic/permanent link and channel link. A permanent link consists 
of up to 90 meters of horizontal network cabling with permanent link test adapters 
at each end. The permanent link (shown below) is used to certify the horizontal 
network cable installation before network connection and user hookup. It 
excludes user patch cords and jumpers. 

Display
Handset

Remote
Handset

2 Meter
Link AdapterPermanent 

2 Meter
Permanent Link Adapter

Network
Patch Panel

RJ-45
Wall Outlet

Horizontal Network Cable
(Maximum of 90 Meters)

  

Figure 4-3: Permanent Link Test Connections 

 
Connection Cable Length Limits 

Horizontal Network Cable Maximum of 90 meters 
Permanent Link Adapters Combined Maximum length of 4 meters 

 
Note: Don’t forget to change the Cable Type to Twisted Pair Basic when working with 

permanent link adapters. 
 
If you exceed the tester length test limits, the tester is required to fail the link. 
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Channel Test Setup 
A channel test setup includes all aspects of the cabling system. It consists of up to 
90 meters of horizontal network cabling, user patch cords, jumpers, and channel 
adapters at each end. The channel test setup (shown below) is used to certify the 
network installation after network connection and user hookup. 

Display
Handset

Remote
Handset

User Patch Cord

Channel Adapter

Channel Adapter User Patch Cord

Network
Patch Panel

RJ-45
Wall Outlet

Horizontal Network Cable
(Maximum of 90 Meters)

 

Figure 4-4: Channel Test Connections 

 
Connection Cable Length Limits 

Horizontal Network Cable Maximum of 90 meters 
User Patch Cords Combined Maximum length of 10 meters 

 

Note: Don’t forget to change the Cable Type to Twisted Pair Channel when working with 
channel adapters. 

If you exceed the tester length test limits, the tester is required to fail the link. 
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Wire Map Test 
Wire Map testing is used to locate shorts, opens and miswires. Test results are 
displayed graphically for easy visual indication of any problems.  

Note: The RH is required to perform this test. 

Wire Map Errors 
A failure in a Wire Map should always be the first problem corrected, since it 
causes faults in other tests. One open pin can cause DC loop resistance and 
attenuation tests to fail. An open may also cause a zero capacitance reading, and 
will cause false readings in NEXT tests. 

A wire map test will always look for and map all nine possible wires (four pairs + 
shield) but will only consider wires defined as present in the selected cable type 
(refer to Chapter 3, Selecting a Cable Type, Page 3-22) for pass/fail criteria. For 
example, a wire that is not specified in the cable type will show on the map but 
will not cause a test failure. 

The Wire Map test guarantees the following minimum level of error detection 
(based upon four pairs of conductors, shield optional): 

• Any wiring error or combination of wiring errors will indicate a wire map 
failure. 

• Any combination of up to three opens, shorts or cross-connections will be 
correctly identified. 

• Opens and shorts will provide an indication of the cable end that the error 
occurred on (provided by Length screen results in Autotest.). 

• Split pairs will be identified based on specific patterns of inconsistent NEXT 
(Near-End Crosstalk). 
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Distance to Fault 
The failed wire pair(s) and the calculated distance-to fault data is displayed at the 
bottom of the wire map test result screen (refer to the example below). The 
distance to the fault is always calculated beginning from the DH unit. 

Note: The LCD diplay is not scaled to represent the calculated distance. 
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Troubleshooting Wiremap Problems 

Problem: One or more open pins 
Probable Causes Connector-to-wire punch down not mated 

Defective jack or plug. 
Broken wire(s). 
 

Other Tests Affected Test   Possible Result 
DC Resistance: Fail. 
Attenuation:  Fail. 
NEXT:   Some false measurements. 
Mutual Capacitance: 0 reading possible. 
Length:  May be low if the open is near the 

Display Handset. 
 

Problem: Shorted pins 
Probable Causes Conductors making contact at a connector. 

Jack or plug has pin or circuit defect. 
Cable damaged. 
 

Other Tests Affected Test   Possible Result 
DC Resistance: Low or zero. 
Attenuation:  Fail. 
NEXT:   Some false measurements. 
Capacitance:  Over limit. 
Length:   Reduced or shorted pairs. 
 

Problem: Miswired pins 
Probable Causes Conductors reversed at a connector. 

 
Other Tests Affected Test   Possible Result 

Usually none Infrequently, one or more tests 
may fail. 
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Wire Length Test 
This test measures the length of each wire pair to make sure that the 
recommended limits for the particular cable type are not exceeded. Depending on 
the units selected in the Setup menu, length is reported in either feet or meters. 
See Chapter 3, Setup information.  

 

Note: The RH is not required to perform this test. 

Length and NVP 
Measuring the length of the cable requires that you know the Nominal Velocity of 
Propagation (NVP) of the cable. Refer to the specification or the manufacturer of 
the cable you are testing for the cable NVP. If the wire specification is not 
available, use a known length of good cable (50 to 100 feet) and adjust the NVP 
until the tester displays the known cable length.  

Wire Length Errors 
Lengths may differ slightly between pairs in the same cable, due to minor NVP 
differences between the pairs and physical length differences due to twisting 
patterns. When electrically measured cable length varies too much from actual 
length, a problem exists. 
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Troubleshooting Wire Length Problems 

Problem: Length between a pair of the same cables varies by more 
than 10%. 
Probable Causes Incorrect NVP. 

Excessive cable length 
Installed matched terminator not functioning correctly. 
Cable insulation damage to longer pairs. 
Break or short in a pair. 
Elevated capacitance on a pair. 
 

Other Tests Affected Test   Possible Result 
DC Loop Resistance:  May be slightly high or fail. 
Attenuation:  May be slightly high or fail. 
 

 

DC Resistance Test 
This test measures the loop resistance of each pair of wires. The instrument tests 
to make sure total loop resistance does not exceed recommended limits. Results 
are displayed with resistance in ohms for each pair, and comparison limit for the 
cable type.  

Note: The RH is required to perform this test. 

DC Resistance Errors 
All four pairs of a network link should have about the same resistance. Pair 
resistance that exceeds the limit is indicated as a failure. The maximum limits in 
the default tables are based on the maximum length limit of the link or cable 
segment. 
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Troubleshooting DC Resistance Problems 

Problem: Excessive Resistance 
Probable Causes Mismatched cable types. 

Poor punch block connection. 
Poor RJ-45 termination connections. 
Wire pair has a tap. 
Cable damage. 
Shorted cable. 
 

Other Tests Affected Test   Possible Result 
Wire Map:  May fail. 
Attenuation:   May fail. 
NEXT:  May have false readings. 
Capacitance:   May fail. 
 

 

Problem: One wire pair has a very high DC loop resistance, others 
are normal. 
Probable Causes Poor connection points. 

Cable damage. 
Connector blades not fully piercing wire insulation. 
Worn Connector. 
 

Other Tests Affected Test   Possible Result 
Wire Map:   May fail. 
Attenuation:   May fail. 
NEXT:  May have false readings. 
Capacitance:   May fail. 
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NEXT, ELFEXT, and Power Sum Tests 
The NEXT (Near End Crosstalk) and ELFEXT (Equal Level Far-End Crosstalk) 
tests measure crosstalk at the near and far ends of the cable in one Autotest. High 
levels of crosstalk can cause excessive retransmissions, data corruption, and other 
problems that slow the network system. 

Note: The RH is required to perform these tests. 

NEXT and ELFEXT 
The NEXT test measures cross-talk from a transmitting pair to an adjacent pair in 
the same cable sheath. NEXT is measured at the both the DH and the RH. 
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Effect of
Adjacent Pair  

The ELFEXT test is similar to the NEXT test except that the traffic is generated 
at the RH and crosstalk is measured at the DH. 

• NEXT measurements are made at each end of the cable for all pair 
combinations (pair 1-2 vs. 3-6, etc.), yielding a total of twelve measurements. 

• ELFEXT measurements are made at the DH for all possible pair 
combinations (1-2 vs. 3-6, 3-6 vs. 1-2, 1-2 etc.) yielding a total of twelve 
measurements. 



Chapter 4 
TS2000 Cable Testing Fundamentals 

 

4-14 

Power Sum NEXT and Power Sum ELFEXT 
Power Sum tests measure the crosstalk effects of three transmitting pairs on the 
fourth pair in the same cable sheath. 
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Effects of
3 Pairs on 1 Pair  

• During the Power Sum NEXT test, six measurements are made at each end of 
the cable and combined (pairs 1-2 / 3-6 / and 4-5 vs. Pair 7-8, etc.) for a total 
of eight measurements.  

• During the Power Sum ELFEXT test, twelve measurements are made at the 
DH side of the cable and combined (pairs 1-2 / 3-6 / 4-5 vs. Pair 7-8, etc.) for 
a total of four measurements. 

Note: Power Sum NEXT measurements will generally read 2 - 3 dB lower in value 
(higher crosstalk) than conventional NEXT. 

NEXT and ELFEXT Errors 
Crosstalk is usually caused by poor connector termination on the ends of the 
cable. The smaller the number, the greater the crosstalk. 
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Troubleshooting NEXT and ELFEXT Problems 

Problem: Low dB test readings 
Probable Causes Installed cable or patch cable not correctly rated. 

Defective, poor quality cable or too many connectors. 
Poor quality installation at the connection points. 
Too much insulation has been stripped from the wires at 
termination. 
A pair of wires has been untwisted too much at termination. 
Split-pairs. 
Poor quality connectors or connectors not rated to desired 
category. 
Delay skew (ELFEXT). 
 

Other Tests Affected Test   Possible Result 
Return Loss:   May be over limit. 
NEXT:    May show same symptoms. 
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Attenuation Test 
This test measures the overall signal strength loss in the cable and verifies that it 
is within acceptable limits.  Low attenuation is essential for error-free 
transmission. Attenuation is measured by injecting a signal of known amplitude at 
the Remote Handset and reading the amplitude at the Display Handset.  

Note: The RH is required to perform this test. 

Attenuation Errors 
Attenuation causes a loss of signal strength over a cable. The loss increases with 
cable length, signal frequency, and temperature. Attenuation testing can be used 
to find problems in the cable, connectors or connecting hardware. The larger the 
number, the greater the attenuation. 

Troubleshooting Attenuation Problems 

Problem: High Attenuation Reading 
Probable Causes Poor connector termination points. 

Excessive cable length. 
Incorrect or poor quality adapter cable. 
Incorrect cable. 
 

Other Tests Affected Test   Possible Result 
DC Loop Resistance: May be high. 
Capacitance:   May be high. 
Length:   May be over limit. 
NEXT:  May be low on pair combinations. 
Average Impedance: May be low. 
Return Loss:  May be over limit. 
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Return Loss Test 
This test measures the ratio of reflected to transmitted signal strength. Good 
quality cable runs will have little reflected signal, indicating good impedance 
matches in the run’s various components. 

Note: The RH is required to perform this test. 

Return Loss Errors 
Like attenuation, excessive return loss reduces signal strength at the receive end. 
It also indicates a mismatched impedance at some point along the cable run.   
A value of 20 dB or greater indicates a good twisted pair cable. A value of 10 dB 
or less is very bad, and causes a large reflection of signal back to the source. 

Troubleshooting Return Loss Problems 

Problem: Excessive Return Loss (Value of 10 dB or less) 
Probable Causes Open, shorted, or damaged cable. 

Installed cable, cable segments, or patch cord have 
improper characteristics. 
Damaged or worn cable or connectors. 
Poor punch-down. 
Factory splice in cable. 
 

Other Tests Affected Test   Possible Result 
Attenuation:  May be high. 
Capacitance and  
Average Impedance:  Could be affected if the impedance 
   mismatch is caused by cable  
   damage. 
DC Loop Resistance: May be high if due to a poor 

punch-down. 
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Average Impedance Test 
Average impedance is derived from electrical delay and capacitance 
measurements. The results of this test are expressed in ohms.  Average impedance 
testing can help identify physical damage to the cable, connector defects, or cable 
segments with incorrect characteristic impedance. 

This test uses capacitive measurements; therefore, it is necessary to specify the 
correct cable type in order to accurately perform the test. 

Note: If a CAT 3 cable is selected (specified as the cable type where PVC is used in the 
cable insulation) but a CAT 5 cable (where Teflon® is used as the cable insulation) 
is actually used, the average impedance will be calculated incorrectly. To avoid this 
problem, be sure to specify the correct cable type. 

Note: The RH is not required to perform this test. 

Impedance Errors 
Impedance errors cause signal reflection and strength reduction.  Average 
impedance of each pair should be equal to the LAN system impedance of 100, 
120, or 150 Ω, plus or minus 15 Ω. 
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Troubleshooting Impedance Problems 

Problem: High Impedance Readings 
Probable Causes Compression, stretching, or excessive bending damage to 

the cable.  
Defective connectors.  
Insulation damage at a connector. 
Ground loops created between cable shielding (if used) and 
equipment grounding (via RS-232 cable to computer, or 
auxiliary power). 
Improperly chosen cables or patch cords. 
Moisture in the cable. 
 

Other Tests Affected Test   Possible Result 
Length:  Affected pairs will appear longer. 
Average Impedance: Change in average impedance is 

inversely proportional to change in 
capacitance. 
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Delay and Skew Test 
This test measures the period of time for a test signal applied to one end of a cable 
run to reach the other end. Skew indicates the difference between the measured 
time delay for that pair and the pair with the lowest value (displayed as 0.0 ns). 
Delay and Skew limits are set according to the currently selected cable type. 

Note: The RH is not required to perform this test. 

Delay and Skew Errors 
Delay and skew measurements will usually differ slightly between pairs in the 
same cable. A substantial difference indicates a cable installation problem or a 
pair defect. 

Troubleshooting Delay and Skew Problems 

Problem: Excessive Differences Between Measurements 
Probable Causes Cables which use different materials for insulating the four 

pairs of wires. 
A break or short in the pair. 
Excessive cable length. 
Cable installation problems. 
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Capacitance Test 
This test measures the mutual capacitance between the two conductors of each 
wire pair to verify that installation has not affected the capacitance for the 
particular cable type.  Bulk capacitance measurements are displayed in nanofarad 
(nF) in the Analyze Capacitance test.  Autotest measures the bulk capacitance in 
picofarads (pF) per foot or meter. 

Note: The RH is not required to perform this test. 

Capacitance Errors 
The larger the capacitance, the higher the error rate.  Small changes in the 
capacitance measurements are normal due to the handling of the cable during 
shipping and installation. The addition of connectors and patch cables will also 
affect capacitance values. 

Troubleshooting Capacitance Problems 

Problem: Capacitance Exceeds the Maximum Limit 
Probable Causes Compression, stretching, or excessive bending damage to 

the cable.  
Defective connectors.  
Insulation damage at a connector. 
Ground loops created between cable shielding (if used) and 
equipment grounding (via RS-232 cable to computer, or 
auxiliary power). 
Improperly chosen cables or patch cords. 
Moisture in the cable. 
Poor connections at punch downs and wall plates. 
 

Other Tests Affected Test   Possible Result 
Length: Affected pairs will appear longer. 
Average Impedance: Change in average impedance is 

inversely proportional to change 
in capacitance. 
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ACR Test 
The ACR (Attenuation-to-Crosstalk Ratio) test performs a mathematical 
comparison (difference calculation) between the results of the Attenuation and 
NEXT tests. The difference reading between each pair gives an indication of how 
problem-free the cable pair will be for transmissions.   

The ACR measurements are calculated pair-to-pair.  The Power Sum ACR 
measurements are calculated by summing the NEXT between a selected pair and 
the other three pairs in the same cable sheath. 

Note: The RH is required to perform these tests. 

ACR and Power Sum ACR Errors 
A large difference reading is desirable, since it indicates a strong signal and little 
noise interference. 

Troubleshooting ACR and Power Sum ACR Problems 
Refer to the NEXT (page 4-15) and Attenuation (4-16) troubleshooting 
suggestions in this chapter. 
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Headroom Test 
The Headroom measurement is a mathematical analysis of the data already 
existing from previous tests.  The calculated value is the sum of the Power Sum 
ACR test (Power Sum ACR of the worst pair after the attenuation for that pair has 
been normalized to 100 meters or 328 feet) and the additional margin between the 
worst case PS NEXT and the limit for PS NEXT. 

Headroom provides a simplified means of reporting the margin available in a 
single cable run which will support an application with error-free performance.  It 
also gives an indication of additional margin, which may be achieved through the 
utilization of “enhanced” cable and connectors and careful installation practices. 

Note: The RH is required to perform this test. 

Headroom Errors 
The Headroom number, reported in dB, characterizes the worst-case margin 
found in a single cable run.  A large number is desirable, since it indicates a 
strong signal and little noise interference.  The pass/fail limit for Headroom is the 
same as Power Sum ACR. 
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Testing and Troubleshooting 10BASE-T Cabling 
10BASE-T Ethernet systems use twisted pair cabling for transmission of network 
data frames. Both the cable and connecting hardware must meet minimum 
standards, as specified in the IEEE 802.3 standard. The default settings for 
10BASE-T network links in the TS2000 tester reflects those standards. 

10BASE-T systems use the 1 and 2 pins for transmit, and the 3 and 6 pins for 
receive, as shown in the following figure. The instrument passes or fails the Wire 
Map based on this pin configuration. If your system does not use the IEEE 802.3 
wiring standard, a custom adapter is required to align nonstandard transmit and 
receive pairs. 

 

Figure 4-5: 10BASE-T Connector 

Note:    Other pairs may be wired but 10BASE-T uses only the pairs shown. 
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Testing and Troubleshooting Token Ring Cabling 
Token Ring Cabling uses two-pair cable and connectors, shielded and unshielded, 
for network data transmission. The cable and connectors for Shielded Token Ring 
systems are very different from those used in 10BASE-T and Structured Wiring 
Systems. The default settings for each type of Token Ring network in the TS2000 
tester is based on maximums for cable and connectors listed in the IEEE 802.5 
standard.  

The TS2000 tester requires the use of special adapters for connection to IBM 
Universal Data Connectors (UDC) or Enhanced Data Connector (EDC). The 
adapter test leads, (TS2032), are shown attached to the Display and Remote 
Handsets in the figure below. 

 

Figure 4-6: Token Ring Test Connections 

When connected to a properly wired Token Ring network link, the adapters will 
return the proper Wire Map. The instrument uses the 3,6 and 4,5 pairs to map the 
two-pair system. When selecting Token Ring cable, be sure to select shielded or 
unshielded to ensure the parameters are correct. If a shielded system is being 
tested, Wire Map will also show the shield continuity. 
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Testing and Troubleshooting with Special Adapters 

Testing with 110 Connecting Block Adapters 
At times, it is necessary to test directly from a 110 connecting block to either a 
patch panel or office outlet. There are two types of 110 adapters that can be used 
with the TS2000 tester: 

• The BLACK BOX® TS2028 adapter used in the 110 Blocks allows testing up to 
155 MHz. 

• A commercially available 8MJ (RJ-45 Style) to 110 block adapter can be used 
to support testing requirements up to 20 MHz (Category 4). 

Use a T568A or T568B adapter test lead to replace one of the test leads supplied 
with the TS2000 tester. Usually this test lead is connected to the Display Handset. 
However if required, it can be connected to the Remote Handset. Connect the 
other handset using one of the test leads supplied with your tester.  

Note: Observe the Wire Map results on the first test carefully. If the Wire Map fails, it may 
indicate a reversal between T568A and T568B wiring standards. Try replacing the 
adapter test lead with the opposite lead and the link should map correctly. 

Testing with Patch Cable Adapters 
The test leads supplied with the instrument are designed for the most common 
testing requirement, installed building cables. 

• The BLACK BOX® Permanent Link test cord (Model TS2010) is designed to 
exceed TIA/EIA Category 5 ISO 11801 specifications, and is specifically 
designed with a Low-Crosstalk male connector for direct connection to the 
Display and Remote Handsets.  The other end of the test cord has an 8MP 
(RJ-45 style) plug for connecting to network patch panels and wall outlets. 

• The BLACK BOX® Channel Adapter (Model TS2025) is specifically 
designed with a Low-Crosstalk jack for direct connection to the network patch 
and equipment cords. 
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Testing with Custom Made Adapters 
Occasionally, testing is required on cable systems that are wired differently than 
the popular pairing configurations standardized by TIA/EIA’s T568A or T568B. 
Special adapters can be made if they are not commercially available. 

All cables and components in a custom test adapter should equal or exceed the 
minimum standards for the link they test. If you attempt to test a Category 5 link 
with a custom adapter containing a Category 4 plug or cable, it will cause failures. 
Even if the link passes the Category 5 testing, the readings will not be 
representative of the actual link quality. 

The TS2000 tests twisted pair cable in specific pairing. When using an adapter, be 
sure the alignment is correct. Compare the wiring schemes for T568A or B and 
USOC, as shown below: 

T568A or B Pairs USOC Pairs 
1,2 1,8 
3,6 3,6 
4,5 4,5 
7,8 2,7 

 
Test results for the 3,6 and 4,5 pairs will be normal, but USOC’s 1,8 and 2,7 will 
be out-of-limit since the pair alignment is incorrect. It should be noted that if only 
the 3,6 and 4,5 pairs are tested, and the connectors are 8MJ (RJ-45 style), no 
adapter is required. Use the test leads supplied with the instrument. 

Please call BLACK BOX® Tech Support (see Appendix B) if you need help when 
fabricating custom adapters. 
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Patch Cable Testing 
Patch cable connectors will wear out from over-insertions. RJ-45 connecting 
hardware is limited to 500-1000 mating cycles before requiring replacement. 

 

Figure 4-7: Cord Test Options 

To perform a Cord Test on Channel and Permanent Link Adapters: 
1. Connect the DH and RH together using a Permanent Link adapter connected 

to a Channel adapter. 

2. Press the  soft key. The tester will display the Cable Type screen. 

3. Position the cursor bar on Misc. Types, and press the  key to open the 
Test Standard screen. 

4. Position the cursor bar on Cord Test Chan+Link, and press the  key to 
change the test standard. 

5. Press the Autotest  key to perform the Cord Test. 

Note: Perform the test on both sets of Channel and Permanent Link Adapters. 
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Contents 
• Setting up Autotest preference 

• How to run an Autotest function 

• Viewing and interpreting Autotest results 

Autotest Overview 
Autotest is the easiest and quickest way to measure and verify your cable 
installation. When the Autotest key is pressed, the TS2000 tester automatically 
performs a series of pre-programmed tests. These test suites are pre-determined 
based on either adopted or proposed standards as well as specific parameters. 
After all tests have been completed, the tester displays a single overall pass/fail 
result and individual test pass/fail results. 

Autotests are performed with the Display Handset (DH) and Remote Handset 
(RH) connected at opposite ends of the cable under test.  

Test Suites 

The tests run during an Autotest depend on the cable type selected (refer to 
Chapter 3, Selecting a Cable Type). Autotest can be preset to automatically save 
test results immediately following each suite of tests, or results can be saved and 
printed manually. To preset these functions, see Autotest Preferences, page 5-6, 
in this chapter. Individual sub-tests can be selected and viewed with more detailed 
data following completion of the Autotest using the Autotest Results screen. 
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Table 5-1: Preset Autotest Suites Available for Specific Cable Types 
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TWISTED PAIR                
CAT 3,  UTP 
 (TIA/EIA568A & TSB67 - Channel) 

•  • • •           

CAT 5,  UTP/STP 
 (TIA/EIA568A & TSB67 – Basic/Channel) 

•  • • •           

CAT 5 Gbit,  UTP/STP 
 (TIA/EIA568A & TSB95 - Basic/Channel) 

•  • • •  • •  •      

CAT 5e, UTP/STP 
 (TIA/EIA568A & TSB67 - Basic/Channel) 

• • • • • • • • • • • • • • • 

CAT 6,  UTP/STP (Draft 5 Proposal) 
 (TIA/EIA568A & TSB67, Basic/Channel) 

• • • • • • • • • • • • • • • 

ISO Class C,  UTP/STP 
 (ISO 11801 - Basic/Channel) 

• • • • • •  • • • •     

ISO Class D,  UTP/STP 
 (ISO 11801 - Basic/Channel) 

• • • • • •  • • • •     

ISO Class D 120,  UTP/STP 
 (ISO 11801 - Basic/Channel) 

• • • • • •  • • • •     

ISO Class D,  UTP/STP (Proposal) 
 (Basic/Channel) 

• • • • • •  • • • •     

ISO Class D 120,  UTP/STP (Proposal) 
 (Basic/Channel) 

• • • • • •  • • • •     

ISO Class E,  UTP/STP 
 (Basic/Channel) 

• • • • • • • • • • • • • • • 

TP-DDI,  STP 
 (Basic/Channel) 

• • • • • •  • • • •     

BOSS,  STP 
 (Basic/Channel) 

• • • • • •  • • • •     

BOSS 120,  STP 
 (Basic/Channel) 

• • • • • •   • • •     

TPPMD,  UTP 
 (Channel) 

• • • • • •  • • • •     

AS/NZS C,  UTP/STP 
 (Basic/Channel) 

• • • • • •  • • • •     

AS/NZS D,  UTP/STP 
 (Basic/Channel) 

• • • • • •  • • • •     

(Table Continues) 
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Table 5-1: Preset Autotest Suites Available for Specific Cable Types (Continued) 

CABLE TYPES 
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ETHERNET                
10BASET 
 (IEEE 802.3) 

• • • • • •          

10BASE2 
 (IEEE 802.3) 

 • • •            

10BASE5 
 (IEEE 802.3) 

 • • •            
 

TOKEN RING                
4MB,  UTP/STP 
 (IEEE 802.5) 

• • • • • •          

16MB,  UTP/STP 
 (IEEE 802.5) 

• • • • • •          

Enhanced A,  STP 
 (IEEE 802.5) 

• • • • • •          
 

MISC. TYPES                
Local Talk • • • •  •          
ISDN • • • • • •     •     
DIN 44312-1 • • • • • •  • • • •     
Bavaria STP (Basic/Channel) • • • • • •  • • • •     
AUTOMATCH • • • • • •   • • •     
ECOMATCH • • • • • •   • • •     
FOILTEK • • • • • •  • • • •     
PAIRTEK • • • • • •  • • • •     
Single Pair • • •   •          
USOC • • • • • •     •     
IBM Coax  • • •            
Twinaxial  • • •            
Arcnet  • • •            
CATV  • • •            

 

FIBER (Please refer to the TS2002 User Manual for more information) 
 

Note: For a detailed test description, refer to Chapter 4, TS2000 Cable Testing Fundamentals. 
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Test Setup 

1. If the TS2000 tester has not been calibrated in the past 24 hours, perform a 
field calibration (See Chapter 3, Calibrating the Tester). 

2. Configure the tester as required (See Chapter 3, Configuring the Tester): 

• Enter User Information • Configure the PC and Printer I/F 

• Set Autotest Preferences • Configure the Talkset Option 

• Adjust Display Contrast • Set Date & Time 

• Set Time-out Options • Select Display Language 

• Set Measurement Units • Restore Factory Defaults 

Note: The tester retains the last configuration settings. You only need to set 
configuration options if one or more parameters have changed. 

3. Select the Cable Type (See Chapter 3, Selecting a Cable Type). 

4. Disconnect the cable to be tested from all network equipment. 

5. Connect the Permanent Link or Channel Adapters to both handsets. 

6. Connect the Display Handset test lead to one end of the link and the Remote 
Handset lead to the opposite end (See Chapter 4, Permanent Link and 
Channel Test Setup). 

Note: TS2000 test leads come with a male connector on one end and an  
RJ-45-style, 110 block or other standard network connector on the opposite 
end. (For a complete list of standard and optional accessories, refer to 
Appendix C). 

7. Power up the Display Handset by pressing the On/Off key. 

Note: The Remote Handset will be powered up automatically by the Display Handset 
when the Autotest initiates. 
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Test Sequence 

When the Autotest button  is pressed, the following actions occur: 

1. The DH will first attempt to communicate with the RH (Remote Handset) 
using one correctly wired pair. If it is unable to establish communication, the 
DH will display a message that it is looking for the RH and continue trying 
until the Autotest is manually canceled or the RH is found. 

2. Once communication with the RH is established, its serial number is checked 
to see if current field calibration data exists. If a field calibration has not been 
performed in the last 24 hours with this RH, the Autotest will be aborted and a 
Calibration Required message will display. 

3. If the serial number is valid, the DH will proceed with the specified Autotest. 
The first test performed in most Autotests is the Wire Map for twisted pair 
cable types. 

4. After running the Wire Map test, Autotest runs the remaining tests specified 
for the currently selected cable type. You have the option of specifying (in 
Autotest Preferences) that testing halt after any failed test or proceed through 
the entire Autotest regardless of test failures. 

Note: All tests after Wire Map will only be performed on valid wire pairs. 

5. Once an Autotest has been completed, all of the test data can be reviewed, 
saved, and printed. 

• The test results for the last Autotest are held in non-volatile memory and 
available for review or storage, even after power is cycled off and back on. 

• The last Autotest results remain in non-volatile memory until replaced by 
new test results or memory is cleared. 
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Autotest Preferences 

Setting your Autotest Preference Options 

1. Select the Preferences  

  Icon. The Preferences 
screen appears 
 

 

2. Select the Autotest 
Preferences option. The 
Autotest Preference screen 
appears. 
 

 

3. Press the Arrow keys or use the Page Up    and Page Down    soft 
keys to position the cursor next to the desired option. 

4. Press    to select or deselect an option. 

5. Press Enter    to accept the selected Autotest Preferences. 
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Running Autotest 
Autotest performs comprehensive tests to measure cabling using programmed 
testing limits. An overall pass or fail is displayed along with individual test 
results.  

Before beginning Autotesting, connect the tester Display and Remote handsets to 
the cable or link to be tested. 

1. Press the Autotest key  . 

2. If the RH unit is not found, a Searching for Remote Handset warning message 
is displayed on the DH. 
 
Press    to cancel the test and return to the Ready screen. 

3. If the RH is found, Autotest compares the cable test readings to standards for 
the cable type selected and issues pass/fail statements for each test. 

4. While Autotest is in progress, a circular timer displays test progress and 
indicates pass or fail for each completed test. 

Note: Press and hold Stop/Cancel    prior to Autotest completion to stop Autotest 
after completion of the test in progress. 

5. When the Autotest is 
completed, an overall result of 
pass  or fail  is 
displayed at the top right of the 
test information columns. 
 
Results for individual tests are 
displayed opposite each test 
name. 
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6. To begin the next Autotest, 
press Autotest  .  

7. If results from the current test 
have not been printed, or you 
did not have AutoSave enabled 
in the Autotest Preference 
screen, you will be prompted 
to discard  or save  
the current test results before 
the next Autotest will run.   

 

Note: The tester also performs real time Analyze testing that enables the user to 
troubleshoot problem areas. If Autotest results indicate a failure, see Chapter 6, 
Analyze Testing. 
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Interpreting Autotest Results 

Pass/Fail Reporting 

The overall Autotest result is 
displayed below the Title Bar at 
the top right of the Autotest 
display screen. Individual Autotest 
results are displayed to the right of 
each test. 

 

Table 5-2: Overall Test Result Symbols 

Symbol Overall Autotest Result 
 Overall test result is a pass if each individual test is a pass or a pass*. 

 
Overall test result is a fail if one or more individual test is either a fail or a 
fail*. 

 
Table 5-3: Individual Autotest Reports 

Symbol Individual Autotest Result 
 Pass 

All values pass with sufficient margin. 
 Pass* 

All values pass, but one or more test values passed by a margin smaller 
than the unit’s specified accuracy for the measurement. 
The pass* result does not fail the cable. However, it is a warning that the 
cable is close to the limit on that parameter and should be inspected as 
soon as possible. 

(Table Continues)
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Table 5-3: Individual Autotest Reports (Continued) 

Symbol Individual Autotest Result 
 Fail 

One or more values fail by a significant margin. 
 Fail* 

One or more values fail, but the margin of failure is smaller than the 
unit’s specified accuracy for the measurement. 
The fail* result fails the cable and must be cleared up, just like a standard 
fail. However, fail* means it has failed by a small margin and minor 
adjustments in the installation may correct the error. 

 

The effect of the pass*/fail* reporting of individual test results is to provide a 
built-in margin of safety above and below the advertised accuracy for a 
measurement. Measurements which fall outside this guard band are a clear pass or 
a clear fail, and the probability of the tester being in error is negligibly small. 
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Viewing Current Autotest Results 

Autotest results can be viewed at the completion of the test sequence or saved for 
later viewing. 

1. Use the Arrow keys to 
position the cursor bar on the 
desired test. 

 

2. Press Enter   to view 
test results. 

 

3. When finished, press    to return to the Autotest screen. 



Chapter 5 
Autotesting 

 

5-12 

Understanding Test Failures 

A failure result for Autotest indicates that one or more tests did not meet 
minimum cable parameter levels for the cable type selected. 

Note: Be sure that you have selected the correct cable type and are using appropriate 
connectors and links. 

Identifying which tests failed and the characteristics of the failure will determine 
the type of fault. If the Autotest shows a failure on a particular sub-test, perform 
Analyze testing (Chapter 6) for the failing test in order to troubleshoot the cable. 

When more than one test fails on Autotest, the test order used for troubleshooting 
is an important element in eliminating the source of the problem.  

If any tests fail, Analyze tests should be run in the following order: 

1. Wire Map  

2. DC Resistance  

3. Length 

4. Delay and Skew 

5. Impedance  

6. Attenuation  

7. NEXT  

8. Dual Return loss  

Refer to Chapter 6 to run these tests in Analyze mode. 
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Using Jobs to Store Test Results  

The TS2000 tester gives you the ability to store cable test results under separate 
Job names. You can create Jobs, assign any name to them, and store test results 
on a Job by Job basis. By using Jobs, you can logically group and store test results 
in a descriptive manner. 

You can set up a separate Job for each floor in a building, each building on a 
campus, each customer, or for any other classification. 

To create a New Job, 

1. Select the Stored Results  
icon and press Enter . At 
this point, you will see a list of 
all the jobs which are currently 
available. If you have never 
created a Job, the list will be 
empty. 

 
 

2. To create a new Job press the 
options  button. The Job 
Options screen appears. Select 
New Job and press Enter . 
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3. Type a name into the text field 
on the New Job screen using 
the alphanumeric keyboard. 
You will need to press a key 
two or three times to get the 
second and third character on 
the key. 
 
Press the right arrow hard key 
to advance to the next character 
position.  

 

Note: Press    to delete a highlighted character. 

4. When you have entered the name, press  . You will return to the Job 
Options screen where you can Access Job information, Delete Jobs, Rename 
Jobs, make a Job the current Job, or create more Jobs.  

Note: When you save test results, they will be stored in the last Job you  
made current. 
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Saving Current Autotest Results  

A maximum of 1,500 TIA Cat 5 individual Autotest results can be stored in the 
TS2000 tester memory and accessed later using the Test Results menu.  

Autotest results can be saved immediately following the test. 

• Only overall passed Autotests are automatically saved. 

• The entire set of test results is saved as one file. 

• Test results are automatically saved if the AutoSave preference is enabled. 
Refer to Setting Autotest Preferences, page 5-6. 

• Test names are automatically assigned to completed tests. If a different name 
is desired, a test can be named manually using Save As . Refer to Step 4, 
below. 

To save Autotest results (AutoSave Disabled): 
1. To manually save an Autotest, press the    key. 

2. The Test Saved screen will be displayed for a brief period, showing the name 
the test is saved under. 

3. If the current name already 
exists, the following Warning 
screen appears. 

 

4. Press   to Escape and return to the previous screen without performing a 
save operation, or Press  to Overwrite the existing file. 
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5. Press  to select the Save As 
option to rename the current test. 
The Save Test screen will 
display with a new name option. 

 

Note: The default Save As name is derived from the cable name entered into the Cable ID 

screen , or from the previous saved name. 
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Printing Current Test Results 

Printing can be done from a test results screen or from stored Autotest results. 
Once a serial printer is connected to the DH, test results are printed by pressing 
the Print  key. The tester does not perform batch printing. 

Note: The Print  key can also be used to upload the test data to a PC communication 
program (i.e. Hyper Terminal) 

Connecting a Serial Printer 
1. Connect a serial printer to the tester’s DB-9 serial port (RS 232) and verify the 

following printer settings (parallel printers will not function with tester): 

• Baud Rate: 9600 

• Data Bits: 8 

• Stop Bit: 1 

• Parity: None 

• Flow Control: XON/XOFF 

2. From the Ready screen, select the Preferences    icon to open the 
Preferences screen. 

3. In the Preferences screen, use 
the Arrow keys to select the 
PC & Printer I/F option. 
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4. In the PC & Printer I/F 
screen, set the correct printer 
parameters. 
 

9600

 

5. Press Enter   to save changes. 

6. Press   to return to the previous screen after setting the printer 
communication settings. 

If the printer does not respond, check the following: 
• Printer indicates “On-Line.” 

• Printer parameters have been correctly set. 

• Correct serial cable is securely fastened to the printer and the DH. 
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Viewing or Deleting Stored Autotest Results  

Test Results contain stored data from Autotest. On the TS2000 tester up to 1,500 
Autotests can be stored in memory. Users can view, print, delete or rename these 
files. 

When an Autotest or an individual test from Analyze is saved, the data is stored 
with a unique name. Test results can be viewed, printed, or deleted from the 
Stored Results screen. 

1. Select the Test Record    
icon to open the Job List 
screen. 

2. Position the highlighted cursor 
over the desired Job. 

• Press  to select 
multiple items for 
processing. 

 

3. Press  Enter  or the Check Box  to select the job for viewing. The 
Stored Results screen opens. 

• Press  to select multiple items for processing. 

4. Repeat step 3 as many times as 
necessary. 

5. Press  to open the 
Options screen. 
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6. Position the highlighted cursor 
over the desired option. In this 
example, the marked job is to 
be deleted from memory. 

7. Press Enter    to perform 
the desired option. 

8. Press Escape    at any 
time to return to the previous 
screen.  

Job and Test Option Tables 
Table 5-4: Job Options 

Option Description 
Current Job Info Total number of tests passed/failed, cable length, 

and headroom for current job. 
All Job Info Total number of tests passed/failed, cable length, 

and headroom for all jobs. 
Delete Selected Jobs Deletes selected jobs from memory. 
Rename Change name of currently selected job. 
New Job Add new job to job list. 
Make Job Current Activates highlighted job.  Saved tests 

(Autotests/Analyze) will be stored in this test. 
Undo Delete Jobs Undo last delete action. 
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Table 5-5: Test Options 

Note: The functions indicated below will only be performed on tests stored in memory. 

Option Description 
Select All Select all stored test results. 
Select All Passed Select only passed test for processing. 
Select By Date Select stored test results by date. 
Select All Failed Select only failed tests for processing. 
De-select All Unmark all stored test results. 
Print Selected Print selected test results. 
Print All Print a summary of stored test results. 
Undo Deleted Tests Undo the last delete action. 
Delete Selected Delete marked test results. 
Delete All Delete all stored test results. 
Result Info Displays test result information such as number 

of tests, number passed and failed, length tested, 
and headroom. 

Selected Result Info Display the results of selected tests. 
Rename Rename a selected test result. 
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Autotest Graphs 
Autotest results can be viewed at the completion of the test sequence in either a 
tabular or graphical format. 

Tabular Format Graphical Format 

  
Graphing Facts 

Graphs can be very useful for viewing test results. There are a few things you 
need to know before you start using them: 

1. In order to view test graphs, graphs must be enabled from the Autotest 
preferences screen before running Autotest. 

2. Graphs are not stored in flash ROM with the test results. 

3. Once you save a test result or run another Autotest, the currently displayed 
graph is permanently erased from the graph memory buffer. 

4. The Limit and worst case Margin parameters are always displayed at the 
bottom of the Tabular test screen. 

5. When you go to graph view, the vertical cursor is always placed at the worst 
case Margin location. 
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To view an Autotest graph: 
1. Configure the Autotest Preferences. Refer to this chapter, pages 5-6. 

2. In Autotest Preferences, make sure the Graphs checkbox is selected. 

3. Press the Autotest  
button. Upon completion of the 
test suite for the cable type 
selected, the Overall Autotest 
results screen displays. 

4. To display tabular data, 
position the cursor on the 
desired test result (the NEXT 
test) and press Enter. 

 

5. To display a graph of the 
tabular data, position the 
cursor on the tabular data of 
interest (pairs 7,8 and 3,6) and 
press Enter. 
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6. The graph will always open 
with the cursor positioned on 
the worst case margin. In this 
example, the cursor is 
positioned on the horizontal 
axis at 74.75 MHz. 

Note: Graphs can only be 
displayed; they cannot be 
saved in memory. 

 

7. Press   to return to the previous screen. 
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Graph Formats, Layouts, and Controls 

Formats 
There are two different graph formats, single and dual plot. For an example of 
each format, refer to the following graphs. 

Single Plot Dual Plot 
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Layout and Controls 
Graphs are useful for observing the relationship between two network cable 
parameters, actual measured parameters and predefined worst case margins.  
The coordinate system of the graph is formed by horizontal and vertical axes. The 
horizontal axis represents frequency data and the vertical axis represents the 
measure values in dB, with limits indicated as a dotted trace. 

Tabular View 

 

Graphical View 

1

2 3

4

5

6

7

8

9

10 11
 

Figure 5-1: Tabular Data and Graphical Plot Layout 

Note: The Margin data at the bottom right of the Tabular screen represents the worst 
case difference between the actual measured data and the predefined limit 
threshold as shown by the cursor position in the graph on the right. 
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Table 5-6: Autotest Graph View Layout and Controls 

Point Function 
1  Wire Pair plotted from tabular data. 
2  The horizontal axis represents frequency data. 
3  The vertical axis is tracked by the cursor. The result represents 

measurements in dB. 
4  When a wire pair graph is first displayed, the cursor is 

automatically positioned at the worst case limit and frequency point 
from the preceding tabular data. 

5  Cursor values for each curve are displayed in the top right and 
bottom right corners of the graph. The values will change as the 
cursor is moved. 

6  Actual data plot for a wire pair. Attenuation is plotted in this 
example. 

7  Predefined worst case limit plot for attenuation. 
8  Predefined worst case limit plot for NEXT. 
9  Actual data plot for a wire pair. NEXT is plotted in this example. 
10  Expands the horizontal axis of the graph about the cursor. Repeated 

operation of this key will repeatedly scale the graph.  At full 
magnification, this key becomes inactive. 

11  Compresses the horizontal axis of the graph about the cursor. 
Repeated operation of this key will repeatedly scale the graph.  
When the full graph is displayed, this key becomes inactive. 

Left/Right 
Arrow Keys 

Used to move the cursor horizontally. As the cursor moves, screen 
readouts will change to reflect cursor position. 

Up/Down 
Arrows Keys 

Used to scroll through the pair or pair combinations from the 
tabular test results screen and display plot data. Repeated up/down 
operations will cycle through the results list and cause a 
wraparound. 
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Chapter 6
Analyze Testing

 

Contents 
• How to run tests in the Analyze single test mode 

• Setting up test preference 

• Viewing and interpreting Analyze test results 

Analyze Single Test Mode Overview 
Analyze mode allows you to troubleshoot by running individual tests, making 
adjustments, and observing changed test results.  For example, a failed 
capacitance measurement can indicate crimped or stretched cable. With Analyze 
testing, you can walk the cable and check for damage and stretching. Freeing the 
cable at suspected problem areas should improve the measured reading.  

Depending on the cable type and defined test standard, any or all of the following 
individual tests are available: 

• Wire Map • DC Resistance • Capacitance 

• Length • Return Loss • ACR 

• NEXT • Delay and Skew • Headroom 

• Attenuation • Impedance • ELFEXT 

• Power Sum NEXT • Power Sum ACR • Power Sum ELFEXT
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Analyze Test Descriptions and Availability  

For an overview of individual tests, refer to Chapter 4, TS2000 Cable Testing 
Fundamentals. The individual tests you can run depend upon the cable being 
tested. Test availability is pre-determined based on the adopted or proposed 
standards, refer to Chapter 5, Test Suites, Table 5-1. 

Test Setup 

1. If the TS2000 tester has not been calibrated in the past 24 hours, perform a 
field calibration (See Chapter 3, Calibrating the Tester). 

2. Configure the tester as required (See Chapter 3, Configuring the Tester): 

Note: The tester retains the last configuration settings. You only need to set configuration 
options if one or more parameters have changed. 

3. Select the Cable Type (See Chapter 3, Selecting a Cable Type). 

4. Disconnect the cable to be tested from all network equipment. 

5. Connect the test leads to both the Display and Remote Handsets using the 
connectors. 

Note: TS2000 test leads come with a male connector on one end and an  
RJ-45-style, 110 block or other standard network connector on the opposite end. 
(For a complete list of standard and optional accessories, refer to Appendix C). 

6. Connect the Display Handset test lead to one end of the link and the Remote 
Handset lead to the opposite end.  

Note: Refer to Chapter 4, Figures 4-3 and 4-4, for connections to complete Permanent 
Link and Channel testing. 

7. Power up the Display Handset by pressing the On/Off key. 

Note: The Remote Handset will be powered up automatically by the Display Handset 
when the Analyze testing initiates. 
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Test Sequence 

When an individual test is run, the following actions occur: 

1. If the test requires the RH (Remote Handset), the DH will first attempt to 
communicate with the RH. If it is unable to establish communication, the DH 
will display a message that it is looking for the RH and continue trying until 
the Analyze test is manually canceled or the RH is found. 

2. Once communication with the RH is established, its serial number is checked 
to see if current field calibration data exists. If a field calibration has not been 
performed in the last 24 hours with this RH, the test will be aborted and an  
appropriate Calibration Required message will display. 

3. If the serial number is valid, the DH will proceed with the specified individual 
test. 

4. If the test does not require the RH, the DH will run the test and display test 
data. 

5. Once a test is run, the test data can be reviewed or printed. 

Analyze Test Screens 

There are a total of 15 Analyze test screens. They are identical to the 
corresponding Autotest screens, with the addition of the Run  key to the soft 
key option row. When this key is pressed, the tester begins continuous execution 
of the selected test. The Halt  key is used to end the test in progress. 

Analyze Test Limitations 

Analyze and Autotest test limitations are identical.  
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Running a Single Test 
Before beginning Analyze testing, connect the Model TS2000 Display and 
Remote Handsets to the cable or link to be tested. 

All Analyze tests are run using the following procedure: 

1. In the Ready screen, select the Analyze    icon to open the Analyze 
screen.  
The Analyze screen lists the tests that can be performed on the currently 
selected cable type (refer to Chapter 3, Selecting a Cable Type). 

2. Use the Arrow keys to position 
the cursor bar on the desired 
test. 
 
In this example, the Length test 
is selected. 

3. Press    to start the test. 

 

4. Upon test completion, the 
tabular results screen is 
displayed. 

5. Press    to run the test in 
continuous mode.  Press and 
hold    to end continuous 
mode testing. 
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Interpreting Analyze Test Results 

Pass/Fail Reporting 
The overall Analyze test result is 
displayed below the Title Bar at 
the top right of the display screen. 
Individual wire pair test results are 
displayed to the right of each test. 

 

 

In the example above, the Length test results screen is displayed. 

• Individual wire pair test results are displayed in the last column on the right 
(Result column). 

• An overall test result of pass    or    fail is displayed at the top right 
above the Result column. 

Overall and Individual test result reporting is usually identical to Autotest mode. 
For a description of symbols and test results, refer to Chapter 5, Pass/Fail 
Reporting. 

Printing Analyze Test Results 

A Tabular test result screen can be sent directly to a serial printer. Before sending 
a result screen to the printer, the printer port needs to be configured. For detailed 
printer setup and screen printing instructions, refer to Chapter 5, Printing Current 
Test Results.  
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Analyze Graphs 

Certain Analyze test results can be viewed at the completion of the test sequence 
in either a table or graphical format.  

1. Run an Analyze test. 

2. Position the highlighted cursor on the desired table data. 

3. Press the Enter key to display the wire pair table data as a graph. 

Analyze graphs are similar to Autotest graphs.  For a description of these graphs, 
refer to Chapter 5, Graph Formats, Layout, and Controls. 
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Chapter 7
Using BB Record Manager 

Software
 

Contents 
• BB Record Manager software installation, startup, and user interface 

• BB Records Manager Help system overview 

• Software configuration and options 

• Importing Autotest data from the tester into a PC database 

• Viewing and printing test reports 

System Requirements 
Your PC should have the following capability:  

Minimum: 486DX-33, 8 MB RAM, 10 MB Free Disk Space, 
Windows 95. 

Recommended: Pentium 90 MHz, 16 MB RAM, 100 MB Free Disk 
Space, Windows 98 and 95, or Windows NT version 
4.0 or greater. 
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BB Record Manager Installation, Startup, and Navigation 

Installation Procedure 

The BB Record Manager software is installed using the standard Windows 95 
program installer. 

1. Insert the BB Record Manager CD-ROM. 

2. Click on the Start button, and then click Run. 

3. Type, d:\ setup 

Note: If your CD-ROM drive is not the “d” drive, replace “d” with the correct drive 
letter. 

4. Follow the instructions on your screen. 

Note: Install BB Record Manager in the default directory, c:\bbrm. 
An empty database will be created in c:\bbrm\db. 

Starting the BB Record Manager Program 

Do one of the following: 

• From the Windows desktop, click on the Start button. Next, click on 
Programs, BB Record Manager, BB Record Manager. 

• From Windows Explorer, go to the bbrm folder and double-click on the 
BBRM application file. 

• Click the Start button and then the Run command, type c:\bbrm\bbrm. 
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Tester to PC Connectivity 

PC Cable 

Use the cable supplied with your Tester (commonly referred to as a Null modem 
cable), to upload test results to a PC. If you supply your own cable, it must be 
wired to the following specifications. 

 

Figure 7-1: PC Uploading Cable Pinout 
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Establishing a Connection 

 

Figure 7-2: PC/Tester Connection 

1. Attach the cable to the tester and an available serial port on the PC or Laptop. 

2. Turn on the tester. 

3. Start the BB Record Manager program on the PC or Laptop. 

4. From the BB Record Manager Options menu, select the Tester ID command. 

The program will automatically scan the available communications ports and 
baud rates to locate and identify an attached tester. If the tester is not identified, 
proceed to the next step. 
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5. Some PCs may have difficulties with this function and the following dialog 
box displays. Click on the OK button. 

 

6. Click on the Options menu, select the Serial Port command. Select the 
correct Port and match the Baud Rate to that of your TS2000 tester. 

7. After you have entered the values, click the Test button. 

• If the tester is identified, its serial and model numbers will be displayed. 

• If you have tried alternative baud rates and ports and BB Record Manager 
still cannot find the tester, call BLACK BOX® Tech Support. 

7. Click on the OK button. 
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BB Record Manager User Interface 

The Menu Bar 

The menu bar is at the top of the screen, directly below the screen title bar. The 
bar displays the pull-down menu names. 

 

When you choose a menu, a list of commands drops down under the menu. You 
can choose only the commands that are solid black. Gray commands or options 
are disabled or may be context sensitive. For example, to use test commands such 
as Find Test and Select Test, the cursor must be in the test grid portion of the 
screen or the commands are not available. 

To open a menu 
1. Move the mouse so that the tip of the mouse pointer is on the desired menu. 

2. Click the left mouse button, or press Alt and then the underlined letter in the 
menu name. 



Chapter 7
Using BB Record Manager Software

 

7-7 

The File menu 

Click on File to display the File pull-down menu. Many of the selections on this 
menu are standard Windows options. 

 

Command Description 

New Create a new database. 

Open Database Open an existing database. More than one 
database can be open at the same time. 

Save Database Save the currently open database 

Close Database Close the currently open database.  

Upload From Tester Pull result data from the TS2000 tester. 

Pack Tester Memory Erase all tests in the tester memory that are 
marked for deletion. 
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Command Description 

Erase Tester Memory Erase all test in the tester memory. 

Export Export test results as Comma-Separated 
Values (CSV) or standard ASCII text files. 

Page Setup Modify the print settings. 

Headers and Footers Insert notes. 

Print  Print a report. 

Backup Database Archive current data in the current folder. 

Restore Database Restore a closed database from a zipped 
archive file into the current folder. 

Re-Index Database Re-index the database. 

Switch To Switch to one of the last three most recently 
accessed databases. 

Exit Exit the application. 
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The Edit Menu 

Click on Edit to display the Edit pull-down menus. 

Job View 

 

Command Description 

Add Job Add a Job. 

Edit Job Modify a Job. 

Delete Delete a job from the database. 

Paste Copy the clipboard contents to the currently 
selected item. 

Upload From Tester Upload a job from the tester to the PC. 

Pack Tester Memory Erase all tests in the tester memory that are 
marked for deletion. 

Erase Tester Memory Erase all test in the tester memory. 

Export Export test results as Comma-Separated 
Values (CSV) or standard ASCII text files. 

Select Job Select an item in the database view in 
preparation for printing or reporting. 
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Command Description 

Select All Select all entries in the database view. 

Find Job… Locate a database item. 
 

Database (Test) View 

 

Command Description 

Add Test Add a Test. 

Edit Test Modify a Test. 

Delete Delete a test from the database. 

Cut Cut the currently selected test(s). 

Copy Copy the currently selected tests to the 
clipboard. 

Paste Copy the clipboard contents to the currently 
selected item. 

Select Test Select a test in the database view for printing 
or reporting. 

Select All Select all tests in the job. 

Set Operator Provide details of the operator for the 
currently selected test. 

Find Test Locate a database test item. 
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The View Menu 

The View pull-down menu allows you to hide or display the toolbar or status bar. 

 

While in database (test) view, select a test and click on the Test Information 
option to open the Test Information window. A red dot on a test tab indicates one 
or more tests on the tab failed. A green dot indicates that all tests on the tab 
passed. Click on a test tab to display stored test results.   
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The Options Menu 

Click on Options to display the Options pull-down menu. 

 

Refer to page 7-19 for a description of the Option menu. 

The Help Menu 

This menu provides the standard windows Help support, and displays the About 
dialog. 

 

The Status Bar  

The Status Bar at the bottom of the screen lists the functions that are currently 
operating and indicates the number of tests residing in the currently highlighted 
job.  
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The Toolbar  

The tools on the toolbar are shortcuts for commands you otherwise access with 
menu commands. 

Tool Button Identification 

 
New 

 
Upload 

 
Open 

 
Get Tester ID 

 
Cut 

 
Set Operator 

 
Copy 

 
Backup 

 
Paste 

 
Select All 

 
Delete Selected 

 
Sort 

 
Export 

 
Find 

 
Import 

 
Help 

 
Print 

 
About 
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The Right Mouse Button 

The right mouse button provides another shortcut to some of the more commonly 
used functions from the Edit menu. This feature is context sensitive; it supports 
different functions depending on where you utilize it.  

BB Records Manager Help System Overview 
You gain access to the BBRM Help system by using the Help menu command.  

Help Topic Menu Option 

The Help Topics menu option is the primary way to gain access to the BBRM 
Help system. 

 

To open the Help System 
1. Pull down the Help menu and click the Help Topics command. The Help 

Topics screen displays. 

Help Topics Screen 

The BBRM Help Topics screen contains three tabs and three buttons. 
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Content Tab 
The Content tab displays a list of topics in the BBRM Help system; it is 
organized by category. 

 

Index Tab 
The Index tab is similar to a traditional book index, listing keywords and phrases 
alphabetically. 
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Find Tab 
The Find tab provides functionality for a full-text search for any word or phrase 
in the Help system. 

Display Button 
The Display button “opens” the selected BBRM Help item. 

Print Button 
The Print button prints the selected item. 

Cancel Button 
The Cancel button closes the BBRM Help system. 
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Using Help Screen 

The Using Help screen is arranged similar to the Help Topics screen. It also 
contains three tabs and 3 buttons. The screen contains instructions for using and 
customizing the BBRM Help system. 
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About BBRM Screen 

The About BBRM screen displays the BBRM version number running on your 
computer. 
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Program Configuration 
Use the Options pull-down menu to configure the BB Records Manager program 
to match your hardware and user preferences. 

 

Table 7-1: Options Pull-Down Menu 

Command Description 
Sort Sort tests in the database view. 

Units Choose feet or meters as the measurement units for 
both the screen display and printouts. 

Serial Port Configure the serial port for your TS2000 tester. 

Font Change the screen display font. 

Language Change the language for both the screen display and 
printouts. 

Save Settings On Exit Save and use the current hardware and user 
preferences the next time the program is started. 

Tester ID Locate and identify an attached tester. 
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Working with Databases 
On start-up, the database that was opened last will automatically reload. 

Note: The first startup of BB Record Manager will load an ‘empty’ database 
(c:\bbrm\db) from the database directory.  

Creating a New Database 

1. Pull down the File menu and click the New command. 

 

2. You can either type the new path and database name or choose Browse and 
select an existing path and then type in the database name. 

Note: The name of the new database displays only in the title bar of the main 
window. 

3. Click the OK button when you are finished. 
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Opening an Existing Database 

1. Pull down the File menu and select the Open command. 

 

2. Type in a file path and name, or use the Browse button to locate the desired 
database folder and file. 

3. Click the OK button to open the database. 

Note: The name of the open database displays in the title bar of the main window only. 
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Working at the Job Level 

Navigating the Job Tree 

Tests are stored in folders called Jobs. For example, each floor of a building can 
be listed as a separate Job. Another Job can represent the entire building or just 
those tests conducted by a particular technician.  

The left side of the Database View shows the hierarchy of Jobs. Clicking on a Job 
folder that is preceded by a plus (+) sign reveals the Jobs it contains. This 
hierarchy can be up to five levels deep. 

 

• Jobs that have attached test records are indicated by a  icon. When you 
click on this icon, the test records become visible.  

• You may move Jobs by selecting and dragging them. Selection is indicated by 
a highlight bar.  



Chapter 7
Using BB Record Manager Software

 

7-23 

Adding a Job 

You must click on the left side of the main database view for the Add or Edit Job 
functions to be available. You can create a new collection of tests by adding a Job 
folder. 

 

1. From the Edit menu, click Add Job. The Add Job dialog box displays. 

 

2. Type in a name for the Job folder and any notes you want to add.  

3. Click OK to create the new job folder. 
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Editing Job 

To change the name of a Job folder or attach some textual notes: 

1. From the Edit menu, click Edit Job. The Edit job dialog box appears.  

 

2. Click on the Name or Note text boxes to perform the desired edits. 

3. Click OK when you are finished. 
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Adding or Editing Customer Details 

You may also want to add or modify customer details on a specific Job entry. 

1. From the Edit menu, select the Edit Job command. 

2.  Click on the Customer button. The Add Customer or Modify Customer 
dialog box displays. 

 

 
3. Add new customer information or edit existing information.  If a customer 

name is supplied it will appear at the beginning of a report. 
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Adding or Changing the Test Set Operator Name 

You may add or change the operator name associated with a given test. 

1. Open a job and position the cursor in the desired test field on the right side of 
the screen. 

2. Select the Edit menu. 

3. Click on the Customer button. The Set Operator dialog box displays. 

 

4. Click on the Drop-down Arrow for a list of all operators. 

5. Select an operator from the drop-down list or enter a new operator name. 

6. Click OK when you are finished. 
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Finding a Job or Test 

The Find function searches for Job Names, Cable IDs and Tests. You can control 
both the type of match and the direction of the search. 

1. Before opening the Find dialog box: 

• Click on a folder at the Job level at the left side of the main database 
screen to find a job. 

• Click on a test in the test grid on the left side of the main database screen 
to find a test. 

2. Select the Edit menu. 

3. Click on the Find Job or Find Test commands. The Find dialog box displays. 

 

4. Enter the job name, then specify the find criteria using the Match case of text 
and Direction to search buttons. 

5. Click on the Find Next button. 

6. Click the Cancel button when you are done searching. 
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Working at the Test Level 

Displaying the Test Grid 

1. Click on a Job folder that contains tests, as indicated by a  icon. 

2. A list of test records will appear in the right side of the Database View. 
This is referred to as the Test Grid.  
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Viewing Test Details 

1. Click on a Job folder that contains tests, as indicated by a  icon. 

2. Double-click on any test entry in the test grid (left side of the main database 
screen) or hold down the Ctrl key and type “V”. Depending on the type of 
cable, you will see individual tabs for each test. 

3. Click on the Tab for the test results that you want to view. 
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Moving Tests Between Jobs 

Tests may be selected and dragged into different Job folders.  

1. Click on a test (or a range of tests) to select it. 

 

2. Move the cursor to the bottom of the highlighted area. The cursor will turn 
into a rectangle. 

3. Click and hold the left mouse button while you drag the test into a new Job 
folder on the left side of the screen. 

4. Release the mouse. 
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Adding and Editing Tests 

These functions become available on the Edit menu when a test record is selected. 
They can also be accessed by using the right mouse button.  

The Find function searches for Job Names, Cable IDs and Tests. You can control 
both the type of match and the direction of the search. 

1. Before opening the Edit menu: 

• Click on a folder at the Job level at the left side of the main database 
screen to find a job. 

• Click on a test in the test grid on the left side of the main database screen 
to find a test. 

2. Select the Edit menu. 

3. Click on the Add Test or Edit Test command. The Add or Edit Test dialog 
box displays. 

4. Enter the cable ID in the text box labeled “From”. Enter the destination of the 
cable in the text box labeled “To.” 

  

 
5. Enter data into the From, To, and Notes text boxes. 

6. Click on the OK button. 
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Sorting the Tests 

The Sort function allows you to reorganize tests in the Database view. You may 
Sort by Result, Cable ID, Cable Origin, Cable Destination, Cable Type, Test 
Type, Date, and Time. The easiest way to sort is to click on a column title. You 
sort by ascending, descending or natural order. The Sort function can be found on 
the Options menu and is available when one or more tests are selected.   

1. On the Options menu, click Sort. 

2. Click the down arrows next to each field and choose from the sorting options 
that are displayed.  

3. Click OK to begin the sort.  

You can sort tests according to three different values, with highest sort criteria 
listed first, followed by the second, and then the least significant sort criteria. 

 

4. Sorting can also be accomplished by clicking on column headers. 
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Finding Data 

The Find function searches for Job Names, Cable IDs and Tests.  
The Find function can be found on the Edit menu. It is context sensitive, and is 
available only when you have an item in the Test grid selected. 

You can control both the type of match and the direction of the search. For 
example, if you are searching for a Test, you should have an item on the Test 
level of the hierarchy selected before bringing up the Find dialog box. 

1. Before opening the Edit menu: 

• Click on a folder at the Job level at the left side of the main database 
screen to find a job. 

• Click on a test in the test grid on the left side of the main database screen 
to find a test. 

2. Select the Edit menu. 

3. Click on the Find Test command. The Find dialog box displays. 

 

4. Enter the test name, then specify the find criteria using the Match case and 
Direction buttons. 

5. Click on the Find Next button. 

 



Chapter 7 
Using BB Record Manager Software 

 

7-34 

Backing Up and Restoring Databases 
Regular data backups to a removable storage device are recommended. You may 
also restore databases to the PC from these archives.  

Backing Up a Database 

This function allows you to back up a database. Following a backup, the program 
will compact the database and remove any deleted records. 

1. Click on the File menu, or click on the toolbar Backup button. 

2. Select the Backup command. The backup will be placed in the current folder. 

Restoring a Database 

This function becomes available on the File menu only after all databases have 
been closed.  

1. Click on the File menu.  

2. If you have a database open, click on the Close Database option and proceed 
to step 3. If you don’t have a database open, proceed to step 4. 

3. Click on the File menu again. 

4. Select the Restore Database command. The backup file will be restored to 
the current folder. 
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Uploading DH Tests to the PC 

Introduction 
The TS2000 is capable of storing tests in individual job folders that can be 
uploaded.  All tests are sequentially stored in base memory. To upload to a job 
folder on the PC, you must create a new job folder or use an existing job folder 
before uploading the tests. 

To create a new database, refer to Creating a New Database, page 9.  To create a 
new job name, refer to Adding a Job, page 12. 

Upload procedure 
1. Designate the upload location on the PC or Laptop. 

• Before uploading test data from the 
TS2000 DH, select a destination database 
in the Database View. 
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2. From the File pull-down menu, Click on the Upload From Tester command. 
The Upload dialog box displays. 

 

3. Click on the desired Upload Test Type button. 

4. Select a job in the Select Upload Job text box. 

6. A status box will remain on screen during the uploading process and you will 
have the option to cancel at any time.  
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Producing and Printing a Report 

Headers and Footers Command 

Headers and footers can be added to your printed report. In a printed report, lines 
will separate the header and footer from the body of the report if the header or 
footer contain any information. 

1. From the File menu, click on the Headers/Footers command.  
The Headers/Footers dialog box displays. 

 

2. Decide on the position for your header or footer and click on the 
accompanying Down Arrow. 
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3. From the selected drop-down text box, select one of the displayed options. 

• If you select Text, the Text Box will open. Enter your information.  

• If you select Logo, you must supply the location of the Bitmap file  
(.bmp file) to be used as the logo.  You can either type the name of the file 
directly into the box titled “Logo File:” or use the Browse function to 
locate the file.   

• Customer is a value that is set on the Edit Job function.  

4. Click on OK. 
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Page Setup Command 

Margins, paper instructions, and printer selection can be set in the Page Setup 
dialog box. Font style and size will be set by the program to maintain a single 
page per test.  

1. From the File menu, Click on the Page Setup command. The Page Setup 
dialog box displays. 

2. Set Paper Size, Source, Orientation, and Margins. 

3. Click on OK. 

Note: You may also need to adjust the space you allocate to the header, footer, and 
margins in order to fit the report on one page. 

 



Chapter 7 
Using BB Record Manager Software 

 

7-40 

Print Command 

Printing involves two steps; selecting the printer, and specifying what you want to 
print. 

1. From the File menu, click on the Print command. The Print dialog box 
displays. 

2. Select Report Type, Printer, Print Range, and number of Copies. 

3. Click on the Preview button to display your report as it will appear in print. 

4. Click on OK. 
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The Single Line Report Layout 

 

 
 

Job Name: Headquarters Report Date: 5/15/03 
Customer: BLACK BOX Corp.  
Operator: User One  
Test Instrument: W TS2000 s/n: 1234567  

 

Cable ID Status Test Date Cable Type Test Standard Test Limit 
Rack1001A Pass 5/10/03 100 Ω UTP TIA CAT 5 Basic   100 MHz 

Rack1001B Pass* 5/10/03 100 Ω STP TIA CAT 5 Channel   100 MHz 

Rack1002A Fail 5/10/03 100 Ω UTP ISO Class D Basic   100 MHz 

Rack1002B Fail* 5/10/03 100 Ω STP ISO Class D Channel   100 MHz 

Rack2010A Pass 5/11/03 150 Ω STP TIA CAT 3 Basic   16 MHz 

Riser1A Pass 5/11/03 MM Fiber TIA 568-A   850 nm 
Bldg1to2 Fail 5/11/03 SM Fiber TIA 568-A   1310 nm 
Panel001A Pass 5/12/03 10BASE5 IEEE 802.3   10 MHz 
Panel002A Fail 5/12/03 TWINAX IBM    10 MHz 

 
Summary Data: 

All Cables Twisted Pair Coax/Twinax Fiber 
Total Tests: 9 Total: 5 Total: 2 Total: 2 
Pass: 5 (56%) Pass: 4 (80%) Pass: 1 (50%) Pass: 1 (50%) 
Fail: 4 (44%) Fail: 1  (20%) Fail: 1  (50%) Fail: 1 (50%) 
 Tot. Length: 1250 ft. Tot. Length: 400 ft.  
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The Brief Report Layout 

A Brief Report only includes tests that contain data. 

 

 
PASS 

Cable ID: Floor7Office1 Cable Type: 100 Ω UTP Test Standard: Custom 

Test Date: 5/15/03 NVP: 69.0 %  Frequency Range: 1 – 100 
MHz 

 
 Result Worst Pair Limit Margin 
Wire Map  PASS     
Attenuation  PASS  11.5 dB 4,5 <21.6 dB 10.1 dB 
Length PASS 276 ft. 1,2 328 ft. 52 ft. 
NEXT PASS 40.1 dB @ 

56.1 MHz 
3,6:4,5 >33.7 dB 6.4 dB 

 

PASS 

Cable ID: Floor7Office2 Cable Type: 100 Ω UTP Test Standard: Custom 

Test Date: 5/15/03 NVP: 69.0 % Frequency Range: 1 – 100 
MHz 

 
 Result Worst Pair Limit Margin 
Wire Map  PASS     
Attenuation  PASS  11.5 dB 4,5 <21.6 dB 10.1 dB 
Length 276 ft. 1,2 328 ft. 52 ft. 52 ft. 
NEXT NOT PASS 40.1 dB @ 

56.1 MHz 
3,6:4,5 >33.7 dB 6.4 dB 

Resistance PASS 5.5 Ω 7,8   

Impedance PASS 103 Ω  1,2 80 – 120 Ω  

Return Loss PASS 18.2 dB 3,6 10.0 dB 8.0 dB 
Delay PASS 800 ns 4,5 850 ns 50 ns 
Delay Skew PASS 25 ns 1,2:7,8 45 ns 20 ns 
ACR PASS 10.0 db 1,2:3,6 10.0 dB 0 dB 
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FAIL 

Cable ID: Floor7Office3 Cable Type: 100 Ω UTP Test Standard: Custom 

Test Date: 5/15/03 NVP: 69.0 % Frequency Range: 1 – 100 MHz 
 

 Result Worst Pair Limit Margin 
Wire Map FAIL  1,2   

Attenuation PASS 11.5 dB 4,5 <21.6 dB 10.1 dB 
Length PASS 276 ft. 1,2 328 ft. 52 ft. 
NEXT FAIL 29.5 dB @ 99.8 MHz 1,2:4,5 >33.7 dB ------- 

Resistance PASS 5.5 Ω 7,8    

Impedance PASS 105 Ω 1,2 80 – 120 Ω  

Return Loss PASS 16.0 dB 3,6 10.0 dB 6.0 dB 
Delay PASS 812 ns 4,5 850 ns 38 ns 
Delay Skew PASS 27 ns 1,2:4,5 45 ns 18 ns 
ACR PASS 12.0 dB 3,6:7,8 10.0 dB 2.0 dB 

 

PASS 

Cable ID: Backbone2 Cable Type: 62.5 µ Multimode 
Fiber 

Wavelength: 850 nm 

Test Date: 5/15/03 NVP: 69.0 %   
Power Loss: 3.4 dB Loss Budget: 5.0 dB Reference (dBm): -20.35 
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The Detailed Layout  

 

 
PASS 

Cable ID: Floor7Office1 Cable Type: 100 Ω UTP Test Standard: Custom 

Test Date: 5/15/03 NVP: 69.0 % Frequency Range: 1 – 100 
MHz 

 

Wire Map 

 

PASS or FAIL:  
Open/Short/Crossed Pair 
etc. 

 
Test Pair: 

1,2 
3,6 4,5 7,8 Limit Result 

Length 250 ft. 247 ft. 251 ft. 250 ft. 328 ft. Pass 
Attenuation 15.0 dB 15.5 dB 15.2 dB 15.1 dB 24.0 dB Pass 
Prop. Delay 200 ns 203 ns 204 ns 199 ns 800 ns Pass 
       
Delay Skew = 5 ns 
(Pairs 4,5 vs. 
7,8) 

45 ns      

       
Avg. Impedance 105 Ω 103 Ω 99 Ω 101 Ω 80-120Ω Pass 

       
Capacitance 5.5 pf 5.2 pf 5.9 pf 4.9 pf   
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NEXT: PASS 

NE/FE PAIRS Result Worst Case Limit Margin 
NE 1,2:3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 1,2:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 1,2:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 4,5:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 4,5:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
      
ACR: 17.1 dB  Headroom: 7.1 dB  

 
Return Loss: FAIL 

NE/FE PAIRS Result Worst Case Limit Margin 
NE 1,2 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 4,5 Fail 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FAIL 

Cable ID: Floor7Office2 Cable Type: 100 Ω UTP Test Standard: Custom 

Test Date: 5/15/03 NVP: 69.0 % Frequency Range: 1 – 100 MHz 
 

Wire Map 

 

PASS or FAIL:  
Open/Short/Crossed Pair etc. 
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Test Pair: 1,2 3,6 4,5 7,8 Limit Result 
Length 250 

ft. 
247 ft. 251 ft. 250 ft. 328 ft. Pass 

Attenuation 15.0 
dB 

25.3 dB 15.2 dB 15.1 dB 24.0 dB Fail 

Delay 200 ns 203 ns 204 ns 199 ns 800 ns Pass 
Delay Skew = 5 ns (Pairs 4,5 and 7,8) 45 ns   

 
NEXT:PASS 

NE/FE PAIRS Result Worst Case Limit Margin 
NE 1,2:3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 1,2:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 1,2:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 4,5:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:3,6 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6:4,5 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 4,5:7,8 Pass 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
      
ACR: 17.1 dB  Headroom: 7.1 dB  

 
Power Sum NEXT 

NE/FE PAIRS Worst Case Limit Margin 
NE 1,2 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 3,6 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 4,5 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
NE 7,8 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 1,2 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 3,6 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 4,5 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
FE 7,8 32.6 dB @ 100 MHz >29.3 dB 3.3 dB 
     
Power Sum ACR: 12.7 dB Power Sum Headroom: 2.1 dB  
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Contents 
• Read all precautions before handling battery packs 

Handle Battery Packs With Care 

CAUTION - All Nickel-Metal Hydride (NiMH) battery packs, regardless of their 
indicated charge state, are capable of producing electrical currents sufficient to 
cause personal injury and/or property damage. 

BLACK BOX® has tried to provide the maximum protection possible by 
installing an automatic reset fuse in every battery pack to help stop high current 
discharges as quickly as possible. However, this fuse may not completely protect 
against a momentary arc, which can result if the battery pack’s electrical contacts 
are shorted. The following are battery pack handling precautions that must be 
closely followed to avoid risk of injury. 

DO NOT dispose of NiMH battery packs in a fire or with regular trash. NiMH 
batteries may explode if exposed to open flame, create hazardous waste and 
contaminate ground water sources if disposed of in land fills. 

The following are battery pack handling precautions: 

• When a battery pack is not installed in the handset or the charger, it should be 
kept in a clean dry non-conductive package. 

• Keep conductive materials away from the battery contacts at all times. 

• Keep the contact sides of the battery packs away from each other at all times. 

• Batteries are normally charged while in the handsets or when using the optional 
Dual Bay Battery Charger.  Charging with other chargers or in any other 
manner may cause the battery packs to explode. 
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• Always install, remove, store and charge the battery packs in a non-explosive 
atmosphere. 

• Use and store battery packs in locations that do not exceed 122 degrees 
Fahrenheit (50 degrees Celsius). 

• Do not allow children or persons unfamiliar with the precautionary instructions 
in this manual to handle or recharge the battery packs. 

• Leave the sealed battery pack case intact. There are no user-serviceable parts 
inside the case and the batteries in the case are not replaceable. 

Statement of Liability 
BLACK BOX® does NOT assume any liability for death, injury or damage to 
equipment or property resulting from the use of this charger in a manner 
inconsistent with the use for which it was intended. BLACK BOX® Corporation 
will not be liable for consequences that may result from tampering with the 
battery packs or charger or consequences resulting from their use thereafter. 

Thanks For Helping To Protect The Environment 
If you have any questions concerning these precautions, the operating 
instructions, or any other concerns about the safe operation of the TS2000 battery 
packs, please contact BLACK BOX® Tech Support (Appendix B). 
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Important User Information 
Please read this information before proceeding with any cable testing/certification 
using the TS2000 tester. 

All the cable parameter default settings preprogrammed in the TS2000 tester are 
based on generic standards, proposed industry recommendations for cables and 
network links, the latest technical information available from International LAN 
cabling standards committees, the LAN industry and BLACK BOX®’s own 
experience and testing. However, the default settings in the tester may not yield 
the desired certification / test results in every given instance because each 
network is a custom installation designed to suit the requirements of the users. It 
is therefore imperative that specific network parameter limits be obtained from 
the network designer(s) and employed during certification and testing. 

Refer to Chapter 3 for information and instructions on how to select the correct 
cable type, change testing methods, and customize the cable’s parameters for 
certification and testing. Chapter 5, Table 5-1 provides a complete list of cable 
topologies supported. 
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Appendix B
Customer Support

 

Customer Service 

Technical Assistance 

For technical assistance or service questions in the U.S.A. and Canada, call 
BLACK BOX® Corporation at 1-724-746-5500. 

Service in the USA 

Your TS2000 tester may require annual calibration to meet accuracy 
specifications.  Before returning a unit for calibration or service, call BLACK 
BOX® Technical Support at 1-724-746-5500. 

If cleaning is required, use a soft cloth and mild cleaner suitable for plastic.  Do 
not immerse in water. 

When returning a unit for service or calibration: 
1. Customer name, company, address, telephone number, proof of purchase (for 

warranty repairs), and a description of the service is required. Use the 
guidelines below to repack the unit with commercially-available materials, if 
the original packing materials are not available. 

2. Pack in soft carrying case, hard-sided carrying case or wrap the instrument in 
heavy paper or plastic. 

3. Use a strong shipping container. A double-walled carton of 250-pound test  
material is recommended. 
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4. Use a layer of shock-absorbing material 70 to 100 mm (3 to 4 inches) thick 
around all sides of the instrument to provide firm cushioning and to prevent 
the unit from moving inside the container. 

5. Seal the shipping container securely. 

6. Ship prepaid to:  

BLACK BOX® Corporation 
1000 Park Drive 
Lawrence, PA 15055-1018 
Tech Support and Ordering: 724-746-5500 
Fax: 724-746-0746 

Return shipping to the customer within the domestic U.S.A. will be paid by 
BLACK BOX® Corporation.  

Service Outside the USA 

For technical assistance or service questions outside the U.S.A. and Canada, call 
your local distributor. 

BLACK BOX® recommends annual calibration of the TS2000 tester to ensure 
that it continually meets its accuracy specifications. Before returning a unit for 
calibration or service outside the U.S.A., contact your local distributor or one of 
the BLACK BOX® offices listed on our website.  If your local distributor does not 
have a service facility, they will provide assistance in returning the tester to an 
authorized BLACK BOX® service facility. 
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World Wide Web  
Download the latest version upgrades, cable test application notes, Q&A forum, 
and product announcements.  

BLACK BOX® provides a World Wide Web (WWW) site for LAN cable test 
products that allows you to use a PC and modem to obtain the latest information 
on cable test application notes or firmware version upgrades.  

You can download the latest firmware upgrades for your TS2000 tester using a 
PC computer. 

To download upgrade files: 
Upgrade files are available on the World Wide Web at: 
 
http:// www.blackbox.com 
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Appendix C
Specifications

 

Standard and Optional Cables, Adapters, and 
Accessories 

 

Model Number Description 

TS2024 Battery Pack Cartridge for Handsets; 
Extra/Spare/Replacement 

TS2027 Headset, Set of 2; Includes earphone, microphone, vinyl 
case and user’s guide 

TS2028 110-Block Link Adapters (568A & 568B); Set of 2 

TS2032 Token-Ring Link Adapters (Type 1,1A,2,6,6A IBM); Set 
of 2 

TS2025 8-Pin Modular Jack Link Adapters; Set of 2 

TS2030 Deluxe Hard-Shelled Carrying Case; holds tester set, 
rechargers, link adapters and accessories 

TS2010 RJ-45 Link Adapters, Set of 2 (Replacements or spares) 

TS2035 AC Power Line Adapter, 120V/60Hz w USA and Canada 
Style Wall Plug (Replacement) 
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Environmental and Physical Specifications 
The following environmental specifications apply to the TS2000 Cable Tester. 

Temperature Range 

Operating Temperature Range: 0 to + 50 degrees C 

Specified Operating Temperature: Field cal ±10 degrees C 

Storage Temperature Range: -20 to +70 degrees C 
 

Humidity 

5-90%, noncondensing 

Shock/Bench Handling 

The TS2000 tester is capable of surviving normal bench handling procedures such 
as found in maintenance and repair facilities. 

Connector Stress 

Strain 
All connectors and adapters will withstand a strain of > 25 lb. in any direction or 
orientation when attached to a DH or RH. 

Jerk 
All connectors and adapters will withstand a jerk force of up to 1 lb. dropped 
from a 3 foot cord in any orientation when attached to a DH or RH. 
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Dimensions and Weight 

Display Handset  

Dimensions: 10"x4.25"x2.5" 

Weight: 1.75 lb. 

Remote Handset 

Dimensions: 10"x4.25"x2.5" 

Weight: 1.6 lb. 

 

Battery and Power Management 

Display Handset  

Battery Pack 8.4 Vdc, 2.45 AH, NiMH 

External Source 12 Vdc, 800mA continuous 

Remote Handset 

Battery Pack 8.4 Vdc, 2.45 AH, NiMH 

External Source 12 Vdc, 800mA continuous 

Test Connector Input Protection 

Input Impedance 2 MΩ 

Voltage Protection 20-200 VAC/DC 
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Instrument Specifications  

Instrument specifications and ranges are described in the following table. 

Parameter Range/Limits 

Length 

 Range 

 Resolution 

 Accuracy 

 Propagation Rate (NVP) 

 

0-1100 ft.  

0.0 ft (.3m) 

3% + 3ft. (1m) 

0.5 - 0.99c 

NEXT 

 Frequency Range 
 

 Dynamic Range 

 Freq. Step Size (kHz) 
 

 Resolution 

 Accuracy 

 

1 - 300MHz 
 

0 - NEXT Limit + 5dB 

150, 250, 500 

 
0.1dB 

Level IIE 
Level III 

Attenuation 

 Frequency Range 
 

 Dynamic Range 

 Freq. Step Size (kHz) 
 

 Atten. Resolution 

 Atten. Accuracy 

 

1 - 300MHz 

 
0 - NEXT Limit + 5dB 

150, 250, 500  
 

0.1dB 

Level IIE 
Level III  
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Parameter Range/Limits 

FEXT 

 Frequency Range 
 
 

 Dynamic Range 

 Freq. Step Size (kHz) 
 

 Resolution 

 Accuracy 

 

1 - 300MHz  
 
 

0 - NEXT Limit + 5dB 

150, 250, 500 
 

0.1dB 

Level IIE 
Level III 

ELFEXT 

 Frequency Range 
 
 

 Dynamic Range 

 Freq. Step Size (kHz) 
 

 Resolution 

 Accuracy 

 

1 - 300MHz 
 
 

0 - NEXT Limit + 5dB 

150, 250, 500  

 
0.1dB 

Level IIE 
Level III  

DC Loop Resistance 

 Range 

 Resolution 

 Accuracy 

 

0 - 200 Ohms 

0.1 Ohms 

+/- (1% + 2 Ω) 
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Parameter Range/Limits 

Return Loss 

 Frequency Range 
 

 Measurement Range 

 Freq. Step Size (kHz) 
 

 Resolution 

 Accuracy 

 

1 - 300MHz  
 

0 - 30 dB 

150, 250, 500 

 
0.1 dB 

Level IIE  
Level III  

Delay and Skew 

 Range 

 Resolution 

 Accuracy 

 

0-8000ns 

1 nsec 

±(3% + 1ns) 

Impedance 

 Range 

 Resolution 

 Accuracy 

 

35 – 180 Ω 

.1 Ω  
+/- (3% + 1 Ω) 

Capacitance (bulk) 

 Range 

 Resolution 

 Accuracy 

 

0 – 100nf 

3 dig 

+/- (2% + 20pF) 

Capacitance (per ft.) 

 Range 

 Resolution 

 Accuracy 

 

0 – 100nf 

0.1pF 

+/- (2% + 1pF) 
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Appendix D
Time Delay Reflectometry

 

The TS2000 tester with Time Domain Reflectometry is one of the most powerful 
diagnostic tools available for metallic cable troubleshooting.  Conventional test 
methods can detect if a cable is shorted or open, but they cannot locate the fault.  
TDR is used to reveal conditions about a cable that simple Pass/Fail reports and 
raw measurements may not show.  The TS2000 tester uses TDR to scan the length 
of a cable for impedance problems, or to accurately verify the cable length. TDR 
is not limited to identifying just shorts or opens - it points out any disturbances in 
the cable. 

TDR is not a test, and there are no TDR standards or pass/fail criteria.  The TDR 
function simply provides a realtime graphical display of cable impedance (y-axis) 
versus length (x-axis).  Impedance is the opposition to signal flow caused by a 
combination of resistance, capacitance, and inductance values of a cable. 

How TDR Works 

A time domain reflectometer works in a manner similar to radar. The TDR tester 
transmits energy into a cable pair and the returning reflections are monitored. 

• The shape of reflection that returns identifies a cable deformity, open, short, 
or termination. 

• The length of time it takes a transmitted pulse to return is used to calculate 
cable length. 

 

TDR Applications 
The following two scenarios show how the TDR function might be used for cable 
inspection and length verification. 
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Scenario - Cable Inspection 

Step Action 

1. New Wiring Installation The wiring contractor installs horizontal and 
backbone cables/wires in accordance with a 
Communication Cable Specification and supplied 
blueprints. 

2. Cable Testing All Autotests results are supplied in hard copy and 
on disk to the owner. 

3. Final Inspection Contractor and Owner conduct final inspection. 

4. Final Acceptance Owner accepts installation. 

5. Office equipment is 
installed by the owner. 

One of the telecommunications outlets appears to be 
faulty. 

6. Owner calls the wiring 
contractor complaining of a 
bad cable. 

The wiring contractor sends a technician out to 
investigate. 

7. The technician runs Auto-
test and TDR on the failed 
network drop. 

A wire pair fails the Crosstalk test.  TDR indicates 
an anomaly at 100 feet from the patch panel. The 
current TDR graph (with anomaly) is saved. 

8. Contractor checks the cable 
at 100 feet out from the 
telecommunications closet. 

The contractor finds a fire extinguisher mounting 
bracket on the cubicle wall. A bracket mounting 
screw has damaged the cable jacket. 

9. Owner is informed that the 
problem is not related to a 
faulty cable or installation. 

Repairs can be authorized by the owner.  The 
contractor will invoice for time and materials. 



Appendix D
Time Delay Reflectometry

 

D-3 

Scenario - Cable Length Verification 

Step Action 

1. Network owner requires the 
installation of an additional 
network drop. 

A wiring contractor is called to install the new 
network drop. 

2. The wiring contractor finds 
additional cable rolled and 
left in the wall. 

The contractor needs to determine if there is enough 
cable left in the wall to install the additional 
network drop. The end of the cable is observed to be 
terminated without a connector. 

3. The contractor needs to 
decide on the best method 
for determining cable 
length. 

A Length Test would not work because it requires a 
Far End unit (FE) to perform the test.  The 
contractor decides to run TDR to determine cable 
length because a Far End unit is not required. 

4. Contractor determines cable 
length. 

The TDR graph is inspected to determine remaining 
cable length. 

5. Contractor recommends the 
most cost-effective 
installation approach. 

The owner approves the installation of the new 
network drop. 
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How to Perform TDR 
Before running the TDR function, connect the TS2000 Display Handset to the 
cable or link to be tested. 

Test Setup 

1. Select the Cable Type (See Chapter 3, Selecting a Cable Type) 

Note: All TDR numerical information is derived from data in the cable database. 

2. Calibrate and configure the tester as required (See Chapter 3, Calibrating the 
Tester and Configuring the Tester). 

Note: The tester retains the last configuration settings. You only need to set 
configuration options if one or more parameters have changed. 
 
The tester will automatically perform a TDR self-calibration if a field calibration 
has not been performed within the past 7 days. 

3. Disconnect the cable to be tested from all network equipment. 

4. Connect the required test lead to the Display Handsets and to one end of the 
link (TDR does not require a Remote Handset). 

Note: TS2000 test leads come with a male connector on one end and an  
RJ-45-style, 110-block or other standard network connector on the opposite end. 
(For a complete list of standard and optional accessories, refer to Appendix C). 
 
Refer to Chapter 4, Figures 4-3 and 4-4, for connections to complete Permanent 
Link and Channel testing. 

5. Power up the Display Handset by pressing the On/Off key. 
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Running a TDR Analyze Function 

1. In the Ready screen, select the Analyze    icon to open the Analyze 
screen.  
The Analyze screen lists the options that can be performed on the currently 
selected cable type (refer to Chapter 3, Selecting a Cable Type). 

2. Use the Arrow keys to position the cursor bar on the TDR function (if the 
TDR option is installed on the tester, TDR is the first option on the Analyze 
menu). 

3. Press Enter    to start the TDR function.  Once started, TDR 
automatically runs in the continuous mode. 

Note: When TDR is running, relays will be heard clicking in the Display Handset. 

4. Once the graph is displayed, note the wire pair being displayed. Use the 
Up/Down Arrow keys to change pairs as required. 

5. Press Stop    to halt continuous mode TDR testing. 

Note: The TDR function significantly reduces battery life. 

6. Press Save As    to name and save the current TDR plot. 

7. Press Escape    to exit the TDR screen and return to normal operation. 

Note: The TDR function is not available through custom cable settings. 
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The TDR Plot 
The TDR plot is a graphical picture of the structure of the cable under test along 
its entire length (2000 ft limit).  This picture is valuable because cable anomalies 
will display features such as blips, peaks, or valleys on an otherwise flat line. 

TDR Plot Layout and Controls 

The coordinate system of the graph is formed by horizontal and vertical axes. The 
horizontal axis represents distance data and the vertical axis represents the 
percentage of reflection. 

1

2

4

5

6

79 8

3

 

Figure D-1: TDR Graphical Plot 

Note: There is no tabular view option for TDR graphs. 
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Table D-1: TDR Graphical Plot Layout and Controls 

Point Function 
1  Actual TDR data plot for a wire pair. When a wire pair graph is 

first displayed, the cursor is automatically positioned at the 
midpoint of the data. 

2  Wire Pair plotted from TDR data. 
3  TDR diagnostic result. Identified as an open, short, or load. 
4  The vertical axis is tracked by the cursor and represents percentage 

of reflection data. 
5  The horizontal axis is tracked by the cursor and represents distance 

data. 
6  Cursor values in ohms and distance (ft or m) at the current 

intersection of the cursor and the plot.  The values will change as 
the cursor is moved. 

7  Name and save a plot of the current screen to Display Handset 
memory.  Up to 32 TDR results can be saved.   

8  Zoom Out soft key.  Expands the horizontal axis of the graph about 
the cursor. 

9  Zoom In soft key.  Compresses the horizontal axis of the graph 
about the cursor. 

 

Viewing TDR Results 

The following are tips to help you understand and view TDR plots. 

• When the TDR diagnostic function is first started, the graphical plot is 
automatically scaled to the full length of the cable. 

• A maximum of 2000 feet (609.6 meters) of cable results can be displayed on a 
TDR graph. 

• When TDR is first activated, the left 10% of the graph displays prelaunch 
impedance signal rise distance data and the right 10% of the graph displays 
reflection data. 
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• No capability for printing of TDR results from the Display Handset or BBRM 
is provided. TDR data acquired via the BB Graphical Analyzer (BBGA) 
application can be saved and printed on a PC. 

• Use the Left/Right Arrow keys to move the cursor horizontally. As the 
cursor moves, screen data displays will change to reflect cursor position. 

• To view TDR results from a different wire pair, press the Up/Down Arrow 
keys.  The TDR test runs one time and displays the results. 

• Repeated operation of the Zoom In    key will repeatedly scale the 
graph.  At full magnification, this key becomes inactive. 

• Repeated operation of the Zoom Out    key will repeatedly reduce the 
graph magnification.  When the full TDR plot is displayed, this key becomes 
inactive. 

• When the graph is fully magnified, bumping the edge of the display with the 
cursor will cause the display to pan the plot (excluding a stored result). 
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Interpreting TDR Results 

Always note the cable pair currently being displayed.  The shape of the reflections 
plotted for the pair can be used to identify and locate problems.  If the cable pair 
has no problems along the entire length of the pair: 

• The graph has an upswing point on the left most 10% of the display (Start of 
Cable). 

• The following 80% of the graph is relatively flat. 

• The graph has an upswing or downswing point on the right most 10% of the 
graph (End of Cable). 

 

Figure D-2: Good TDR Graphical Plot 
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Evaluating a TDR Graph 
When evaluating the TDR graph the first consideration should be the average 
impedance of the cable being tested.  A graph with sharp dips or spikes can 
identify radical shorts or opens.  For subtle problems, interpretations should be 
based on benchmark data obtained from the analysis of many cable segments.  
When anomalies are detected in the cable pair, the cursor is automatically placed 
on the first anomaly.  Use the Arrow keys to position the cursor on the anomaly of 
interest.  Impedance and distance values will be displayed on the screen.  

The following troubleshooting tips identify typical cable conditions and their 
corresponding screen plots. 

Condition TDR Plot Indication 
Open, Near End Upswing develops early. In comparison to good 

cable pairs, this pair appears shorter in length. 
Short, Near End Downswing develops early. In comparison to good 

cable pairs, this pair appears shorter in length. 
Open, Far End Fully developed upswing at the Far End. 
Short, Far End Fully developed downswing at the Far End. 
Split Pair 20 to 30% rise in relative impedance at the split with 

a corresponding drop in impedance where the pair is 
reconnected. 

Cable segment with higher than 
nominal impedance 

Peak in the level area of the plot. 

Cable segment with lower than 
nominal impedance 

Dip in the level area of the plot. 

Level Plot, much higher than 
the known cable NVP 

Wrong cable type selected, or wrong cable type 
installed. 

No distinct upswing or 
downswing at the Far End 

Matched terminator attached to the cable. The pair 
appears to have a very long length. 
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Storing, Retrieving, and Deleting TDR Results 

Storing a Graph 
The TDR results can be stored in the current Job.  For detailed instructions 
regarding using jobs to store test results, refer to Chapter 5, Using Jobs to Store 
Test Results. 

1. Using the Up/Down Arrow keys, select the desired cable pair graph. 

2. Press the Save As    key. 
The Save Test screen is 
displayed. 

 

 

3. The test name is automatically assigned.  If a different name is desired, use 
the Delete Character    key to change the highlighted character. 

Note: The default Save As name is derived from the cable name entered into the Cable 

ID screen , or from the previous saved name.  Refer to Chapter 3, Cable 
ID/Autoname Option. 

4. When you have entered the name, press  .  You will return to the Ready 
screen. 

Retrieving or Deleting a Graph 
For detailed instructions regarding retrieving or deleting stored TDR results, refer 
to Chapter 5, Viewing or Deleting Stored Autotest Results. 
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